
 

CallPilot
Troubleshooting Reference

Product releases 1.0 to 2.02 Standard 1.0 May 2003



P0913837



CallPilot
Troubleshooting Reference

Publication number:  P0913837
Product releases: 1.0 to 2.02
Document release: Standard 1.0

Date: May 2003

Copyright © 2003 Nortel Networks, All Rights Reserved

Information is subject to change without notice. Nortel Networks reserves the right to make changes in design or 
components as progress in engineering and manufacturing may warrant.

The process of transmitting data and call messaging between the CallPilot server and the Meridian 1 switch or 
Succession CSE 1000 system is proprietary to Nortel Networks. Any other use of the data and the transmission 
process is a violation of the user license unless specifically authorized in writing by Nortel Networks prior to such use. 
Violations of the license by alternative usage of any portion of this process or the related hardware constitutes grounds 
for an immediate termination of the license and Nortel Networks reserves the right to seek all allowable remedies for 
such breach.

This page and the following page are considered the title page, and contain Nortel Networks and third-party 
trademarks.



*Nortel Networks, the Nortel Networks logo, the Globemark, and Unified Networks, BNR, CallPilot, DMS, DMS-100, 
DMS-250, DMS-MTX, DMS-SCP, DPN, Dualmode, Helmsman, IVR, MAP, Meridian, Meridian 1, Meridian Link, 
Meridian Mail, Norstar, SL-1, SL-100, Succession, Supernode, Symposium, Telesis, and Unity are trademarks of 
Nortel Networks. 

3COM is a trademark of 3Com Corporation.

ACCENT is a trademark of Accent Software International Ltd.

AMDEK is a trademark of Amdek Corporation.

AT&T is a trademark of American Telephone and Telegraph Corporation.

ATLAS is a trademark of Quantum Corporation

ATRIA is a trademark of Pure Atria Corporation.

CASEWARE is a trademark of Caseware International, Inc.

CONTINUUS is a trademark of Continuus Software Corporation. 

CRYSTAL REPORTS is a trademark of Seagate Software Inc.

DEFINITY is a trademark of Avaya Inc. 

DIALOGIC is a trademark of Dialogic Corporation.

EUDORA is a trademark of Qualcomm. 

EXCHANGE.NET, INTERNET EXPLORER, LINKEXCHANGE, MICROSOFT, MICROSOFT EXCHANGE SERVER, 
MS-DOS, OUTLOOK, POWERPOINT, WINDOWS, WINDOWS MEDIA, and WINDOWS NT are trademarks of 
Microsoft Corporation.

GROUPWISE and NOVELL are trademarks of Novell Inc.

HITACHI is a trademark of Hitachi Limited.

INTEL is a trademark of Intel Corporation.

LOGITECH is a trademark of Logitech, Inc. 

LUCENT is a trademark of Lucent Technologies, Inc.

MATRA is a trademark of Matra Hachette.

NETSCAPE COMMUNICATOR is a trademark of Netscape Communications Corporation.

NOTES is a trademark of Lotus Development Corporation.

PCANYWHERE is a trademark of Symantec Corporation.

PROMARK and RHOBOT are trademarks of DMI Promark, Inc.

RADISYS is a trademark of Radisys Corporation.

ROLM is a trademark of ROLM Systems.

SLR4, SLR5, and TANDBERG are trademarks of Tandberg Data ASA.

SONY is a trademark of Sony Corporation.

SYBASE is a trademark of Sybase, Inc.

TEAC is a trademark of TEAC Corporation.

UNIX is a trademark of X/Open Company Limited.

US ROBOTICS, the US ROBOTICS logo, and SPORTSTER are trademarks of US Robotics.

VOICEBRIDGE is a trademark of Voice Technologies Group Inc.

WINRUNNER is a trademark of Mercury Interactive Corporation.



Publication history

May 2003 Standard 1.0 version of the CallPilot Troubleshooting Reference is updated 
for CallPilot release 2.02 to reflect changes in the Meridian Mail migration 
troubleshooting procedures. “Symptom 14: SCCS unable to de-acquire 
resources after improper shutdown or crash” has been added to Chapter 2, 
“Hardware troubleshooting”.

October 2002 Standard 1.0 version of the CallPilot Troubleshooting Reference is updated 
with additional information pertaining to CallPilot 2.0. 

September 2002 The CallPilot Troubleshooting Reference is updated with information 
pertaining to CallPilot 2.0.
Troubleshooting Reference v



Publication history  Standard 1.0
vi CallPilot



Contents

1 Overview 9
Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
CallPilot documentation references. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
CallPilot 2.02 documentation references. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
CallPilot 1.07 documentation references. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
CallPilot 1.06 documentation references. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Document title . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Document number . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
CallPilot 1.0 documentation references. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

2 Hardware troubleshooting 13
Symptom 1: CallPilot server fails to start (no message) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Symptom 2: The server fails to start (BIOS abnormal device message). . . . . . . . . . . . . . . . . . . . . . . . 21
Symptom 3: The server fails to start (beep codes are generated) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
Symptom 4: The server fails to start (BIOS cannot identify hard disks)  . . . . . . . . . . . . . . . . . . . . . . . 24
Symptom 5: The server starts but the tape drive does not function  . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
Symptom 6: Server unable to boot into NT  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Symptom 7: The screen image moves back and forth (201i server only). . . . . . . . . . . . . . . . . . . . . . . 30
Symptom 8: The 201i server restarts randomly and unpredictably. . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Symptom 9: Error message "Can’t find Cirrus Logic PCMCIA controller..."
interrupts CallPilot installation (201i server only)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Symptom 10: System fails to boot (boots to a blue screen or freezes) . . . . . . . . . . . . . . . . . . . . . . . . . 33
Symptom 11: Modem does not function . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Symptom 12: CD-ROM drive does not function  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Symptom 13: Serial ports do not function  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Symptom 14: SCCS unable to de-acquire resources after improper shutdown or crash  . . . . . . . . . . . 52

3 Network troubleshooting 53
Symptom 1: Server fails to connect to any network . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
Symptom 2: Server fails to connect to the embedded LAN (ELAN) . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Symptom 3: Server fails to connect to the CLAN (Customer LAN)  . . . . . . . . . . . . . . . . . . . . . . . . . . 58
Symptom 4: The CallPilot server is unable to communicate over the 
network (the ELAN, CLAN, or both) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
Symptom 5: 201i server is unable to communicate over the network with 
3COM Megahertz CLAN . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

4 Remote access troubleshooting 67
Symptom 1: Unable to connect to CallPilot server using pcAnywhere . . . . . . . . . . . . . . . . . . . . . . . . 68
Symptom 2: Dial-Up Networking connects, but the pcAnywhere 
connection on the administrative PC fails. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
Symptom 3: The administrative PC cannot access shared network 
resources when a dialup connection is established . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Symptom 4: Remote modem answers, Dialup Networking displays 'Verifying User' 
message, and logon process fails. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Troubleshooting Reference vii



Contents Standard 1.0
Symptom 5: pcAnywhere connects, but the file transfer program is not 
launched and Ctrl-Alt-Del does not work . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
Symptom 6: pcAnywhere connects, but updates are extremely slow, or only 
a small portion of the screen is refreshed . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
Symptom 7: Remote Access Service (RAS) is not running . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

5 Application troubleshooting 75
Symptom 1: Call answered, no voice . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
Symptom 2: A user cannot log on to the mailbox from an external phone. . . . . . . . . . . . . . . . . . . . . . 79
Symptom 3: Speech recognition does not work . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
Symptom 4: Users cannot print or receive faxes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

6 Meridian Mail migration troubleshooting 83
Symptom 1: Error reading tape during data transfer or message migration . . . . . . . . . . . . . . . . . . . . . 84
Symptom 2: All users could not be migrated due to invalid user preferred language ID. . . . . . . . . . . 86
Symptom 3: Failed to create map directory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
Symptom 4: Automatic log file backup failed  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88
Symptom 5: On a recently migrated system, a user cannot log on to the mailbox or
CallPilot does not recognize a user receiving an incoming call . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

A Part numbers 91
viii CallPilot



C h a p t e r  1

Overview

Introduction

This reference provides step-by-step troubleshooting procedures for CallPilot release 2.02. There 
may be minor differences for these procedures between various CallPilot releases.

Each troubleshooting area contains symptom tables outlining basic checks that include 
diagnostics and resolutions for each check. This guide is applicable to all CallPilot servers. 
Exceptions are noted for each server, where necessary, in the heading for each symptom or 
check. The appendix in the back of this document contains a listing of parts referred to in this 
reference.

This document provides basic procedures for troubleshooting; you can find further information 
in the CallPilot documentation. Specific references are provided throughout this document. 
Below is a list of the related documents.

CallPilot documentation references

CallPilot 2.02 documentation references

Document title Document number

CallPilot Installation and Configuration, 
Part 3: Meridian 1 and CallPilot Server 
Configuration

NTP 555-7101-222

CallPilot Installation and Configuration, 
Part 3: Succession CSE 1000 and 
CallPilot Server Configuration

NTP 555-7101-510

CallPilot Installation and Configuration 
Part 4 Software Installation and 
Maintenance

NTP 555-7101-202

CallPilot Installation and Configuration 
Part 2: 201i Server Hardware Installation

NTP 555-7101-220

CallPilot Installation and Configuration 
Part 5: 201i Server Maintenance and 
Diagnostics

NTP 555-7101-119

CallPilot Installation and Configuration 
Part 2: 702t Server Hardware Installation

NTP 555-7101-215
Troubleshooting Reference 9



Overview Standard 1.0
CallPilot Installation and Configuration 
Part 5: 702t Server Maintenance and 
Diagnostics

NTP 555-7101-216

CallPilot Installation and Configuration 
Part 2: 1001rp Server Hardware Installation

NTP 555-7101-217

CallPilot Installation and Configuration 
Part 5: 1001rp Server Maintenance and 
Diagnostics

NTP 555-7101-206

CallPilot Installation and Configuration 
Part 2: 1002rp Server Hardware Installation

NTP 555-7101-205

CallPilot Installation and Configuration 
Part 5: 1002rp Server Maintenance and 
Diagnostics

NTP 555-7101-206

CallPilot 2.02 Administrator’s Guide NTP 555-7101-301

CallPilot Meridian Mail to CallPilot 
Migration Utility Guide

NTP 555-7101-801

CallPilot 1.07 documentation references

Document title Document number

CallPilot Documentation Addendum not applicable

CallPilot Installation and Configuration, 
Part 2: 200i Server Hardware Installation

NTP 555-7101-213

CallPilot Installation and Configuration, 
Part 5: 200i Server Maintenance and 
Diagnostics

NTP 555-7101-214

CallPilot Installation and Configuration, 
Part 2: 201i Server Hardware Installation

NTP 555-7101-220

CallPilot Installation and Configuration, 
Part 5: 201i Server Maintenance and 
Diagnostics

NTP 555-7101-119

CallPilot Installation and Configuration, 
Part 2: 702t Server Hardware Installation

NTP 555-7101-215

CallPilot 2.02 documentation references

Document title Document number
10 CallPilot



May 2003 Overview
CallPilot Installation and Configuration, 
Part 5: 702t Server Maintenance and 
Diagnostics

NTP 555-7101-216

CallPilot Installation and Configuration, 
Part 2: 1001rp Server Hardware Installation

NTP 555-7101-217

CallPilot Installation and Configuration, 
Part 5: 1001rp Server Maintenance and 
Diagnostics

NTP 555-7101-218

CallPilot Installation and Configuration, 
Part 3: Switch Setup and CallPilot Server 
Configuration

Note: For Meridian 1, use NTP 555-7101-222 
below.

NTP 555-7101-211

CallPilot Installation and Configuration, 
Part 3: Meridian 1 Switch Setup and CallPilot 
Server Configuration

NTP 555-7101-222

CallPilot Installation and Configuration, 
Part 4: Client Software Installation

NTP 555-7101-212

CallPilot Administrator’s Guide NTP 555-7101-300

CallPilot Monitoring and Security for the 
Administrator

NTP 555-7101-500

CallPilot Meridian Mail to CallPilot 
Migration Utility Guide

NTP 555-7101-801

CallPilot 1.06 documentation references

Document title Document number

Meridian Applications Server 1001rp 
Installation and Maintenance Guide

NTP 555-7101-252

CallPilot 1.07 documentation references

Document title Document number
Troubleshooting Reference 11



Overview Standard 1.0
CallPilot 1.0 documentation references

Document title Document number

Meridian Applications Server 200i 
Installation and Maintenance Guide

P0903075

Meridian Applications Server 702t 
Installation and Maintenance Guide

P0884909

CallPilot Software Installation Guide NTP 555-7101-200

CallPilot Maintenance and Diagnostics 
Guide

NTP 555-7101-500

CallPilot Basic Administration Guide NTP 555-7101-301
12 CallPilot
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Hardware troubleshooting
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Hardware troubleshooting Standard 1.0
Symptom 1: CallPilot server fails to start (no message)

Diagnostic steps Resolution

Check the monitor.

1 With system power on, verify that the 
monitor LED is lit green.

2 If the monitor LED is not lit green, then the 
monitor may be defective.

3 Adjust monitor Contrast and Brightness 
settings to the default values.

4 Connect the monitor to known good 
working system or PC.

5 If the monitor LED is still not lit green and 
the amber light is not flashing, confirm the 
power cable is connected.

6 If the light is blinking amber and the system 
is a 200i or 201i server, then reseat the 
CallPilot server. 

7 If the monitor light still does not turn green, 
then the monitor is probably defective.

A Replace the monitor.

1001rp server: Has the SBC BIOS been flashed?

8 If you have recently flashed the BIOS and 
your system is completely unresponsive, 
the BIOS flash may not have worked.

9 Proceed with crisis recovery.

B Create a Crisis Recovery diskette 
using the NTRH8042 diskette on 
another PC as follows:

� In DOS mode, copy the contents 
of the NTRH8042 diskette into a 
temporary directory.

� Put a blank diskette in the floppy 
drive and from the temporary 
directory, type crisdisk and press 
Enter.

� Type makeboot and press Enter 
to make the disk bootable.

C Using the manufacturer’s 
documentation, locate switch block 
SW1 on the SBC. SW1 contains four 
switches.

D With the system power off, set DIP 
switch 2 to the closed/on position. 
The default setting is open/off.

E Put the Crisis Recovery diskette in 
the floppy drive.
14 CallPilot



May 2003 Hardware troubleshooting
1001rp server: Has the SBC BIOS been flashed? 
(continued)

F Turn the power on. At power up, the 
only devices which will work are the 
floppy controller, floppy drive, and 
speaker. No messages will be 
displayed, but you will hear a series 
of beeps.

G When the beeps stop (after 
approximately 15 seconds), remove 
the diskette and switch the power off.

H Set DIP switch 2 back to its default 
setting (open/off).

I Turn the power on again. The system 
should boot normally and prompt for 
setup.

1001rp server: Check the video card.

10 The video card may be defective.

J Replace the video card. Refer to 
CallPilot Installation and 
Configuration Part 5: 1001rp Server 
Maintenance and Diagnostics, 
“Replacing the video card.”

Check the Keytronic keyboard.

11 Check the back of the keyboard to verify 
that 

� The model is Keytronic 
EO3601QUS201-C.

� The date code is later than "9940" 
(October 1st, 1999). 

� The date code is included in the Serial 
Number on the back of the keyboard. 
(For example, S/N: Q994407128 
contains the date code "9944", which 
translates to year 99, week 44. The date 
in this instance would be November 1st, 
1999.)

12 If the system starts properly without the 
keyboard, the keyboard may be defective. 

K Replace the Keytronic keyboard with 
part number NTRH9013.

13 Does the problem still exist? L Does the keyboard have an integrated 
pointing device, such as a trackball? 

� If so, check the keyboard's 
pointing device.

� If not, check the mouse.

Symptom 1: CallPilot server fails to start (no message)

Diagnostic steps Resolution
Troubleshooting Reference 15



Hardware troubleshooting Standard 1.0
Check the keyboard’s pointing device (if 
applicable).

14 If the system starts properly, the integrated 
pointing device may be defective.

M Replace the integrated mouse.

702t or 201i server: Check the motherboard.

15 The motherboard may be defective.

N Contact your Nortel Networks 
technical support representative for 
assistance.

16 Does the problem still exist? O Check the memory module.

Check the memory module.

17 Verify that the memory module (DIMM or 
SIMM) is present.

18 Verify that the memory module (DIMM or 
SIMM) is properly seated.

19 Verify that the memory module (DIMM or 
SIMM) is qualified. The qualified memory 
modules for the 201i server are as follows:

� Samsung KMM374F1600BK1-6

� Kingston Technology 
KTM16X72VN84-60EG

� SMART Modular Technologies 
SM572168094D6G6

� SMART Modular Technologies Inc 
SM57216809UDUGU

P If the memory module is missing, 
contact Your Nortel Networks 
technical support representative for 
assistance.

Q Reseat the memory module. Refer to 
the appropriate documentation for 
your server:

� CallPilot Installation and 
Configuration, Part 5: 702t 
Server Maintenance and 
Diagnostics, “Replacing 
baseboard DIMMs”

� CallPilot Installation and 
Configuration, Part 5: 1001rp 
Server Maintenance and 
Diagnostics
— “Dual Inline Memory

Modules” in “Maintaining
the Pentium II SBC Card” or 

— “Replacing or adding Dual
Inline Memory Modules” 
in “Maintaining the
Pentium III SBC card.”

� CallPilot Installation and 
Configuration, Part 5: 1002rp 
Server Maintenance and 
Diagnostics, “Replacing or 
adding Dual Inline Memory 
Modules” in “Maintaining the 
Pentium III SBC card”

20 Does the problem still exist? R Check the keyboard.

21 Does the problem still exist? S Check the mouse.

Symptom 1: CallPilot server fails to start (no message)

Diagnostic steps Resolution
16 CallPilot



May 2003 Hardware troubleshooting
22 Does the problem still exist? T 1001rp server: Check the video 
card.

U 702t or 201i server: Check the 
power supply.

1001rp server: Check the video card.

23 Verify that the video card is seated properly, 
and in the correct slot. 

V Reseat the video card in the correct 
PCI slot location. Refer to CallPilot 
Installation and Configuration, 
Part 5: 1001rp Server Maintenance 
and Diagnostics, “Replacing the 
video card.”

1001rp server: Recheck the video card.

24 If you reseated or moved the video card, 
power up the server.

25 If the fans start, the disk LEDs come on, 
and the server appears to start, then the 
video card may be defective.

W Replace the video card.

26 Does the problem still exist? X Check the power supply.

1001rp server: Check the power supply.

27 Verify that the AC (DC) power supplies are 
installed in AC (DC) systems. Refer to 
CallPilot Installation and Configuration, 
Part 5: 1001rp Server Maintenance and 
Diagnostics, “Replacing the power supply” 
in “Replacing basic chassis components.”

28 If the LEDs on the back of the server are 
not green, the power supply may not be 
inserted properly or may be defective.

Y Remove and reinsert the power 
supply.

Z Note: In the case of the 48V DC 
power supply, the leads may have 
been reversed. Reversed leads will 
not damage the system but will 
prevent booting.

AA Replace power supply or supplies 
with

� A0723663 - 48V DC 400W load 
sharing hot swap power supply

� A0769126 - 220V-only Power 
Supply w/o 3.3V output (3 Rail)

� A0805434 - Power Supply 500W 
Hot swappable

1001rp server: Check the power supply cabling.

29 Ensure that a power supply cable is 
securely connected to a known working AC 
outlet.

30 Power up the server and listen/feel to verify 
that the power supply fan is operational.

AB Replace the power cable.

Symptom 1: CallPilot server fails to start (no message)

Diagnostic steps Resolution
Troubleshooting Reference 17



Hardware troubleshooting Standard 1.0
1001rp server: Check the power supply cabling 
(continued)

31 If the fan is not operational, the AC power 
cable may be defective.

See the previous page.

1001rp server: Check power supply fan.

32 Open the server and detach the power 
supply’s internal cabling from all devices 
except the motherboard.

33 Power up the server and listen/feel to verify 
that the power supply fan is operational. 
The cooling fan is at the front of the hot-
swap power supply module.

34 If the fan is not operational, use a volt meter 
to verify that the two outside pins of the 4-
pin power connector generate the 
following:·

� +5 Volts

� +12 Volts 

35 If either of these is incorrect, the power 
supply may be defective.

AC Remove and reinsert the power 
supply.

AD If the voltages are incorrect, replace 
power supply or supplies with

� A0723663 - 48V DC 400W load 
sharing hot swap power supply

� A0769126 - 220V-only Power 
Supply w/o 3.3V output (3 Rail)

� A0805434 - Power Supply 500W 
Hot swappable

1001rp server: Check the motherboard.

36 If the server still does not start, then the 
server's motherboard may be defective.

AE Do the following:

� Replace the chassis. 

� Contact your Nortel Networks 
technical support representative 
for assistance. 

702t server: Check the power supply.

37 Ensure that the power supply cable is 
securely connected to a working AC outlet.

38 Power up the server and listen/feel to verify 
that the power supply fan is operational. 
The fan is at the top rear of the server.

39 If the fan is not operational, the AC power 
cable may be defective.

AF Replace the power cable.

702t server: Check the power supply fan.

40 Open the server's housing and detach the 
power supply's internal cabling from all 
devices except the motherboard.

AG Replace the power supply. Contact 
your Nortel Networks technical 
support representative for assistance.

Symptom 1: CallPilot server fails to start (no message)

Diagnostic steps Resolution
18 CallPilot



May 2003 Hardware troubleshooting
702t server: Check the power supply fan 
(continued)

41 Power up the server and listen/feel to verify 
that the power supply fan is operational.

42 If the fan is not operational, use a voltmeter 
to measure the two outside pins of the 4-pin 
power connector with ground. One should 
be +5 Volts, the other +12 Volts. If either of 
these is incorrect, the power supply may be 
defective.

See the previous page.

702t server: Check the motherboard.

43 If the server still does not start, then the 
server’s motherboard may be defective.

AH Replace the server. Contact your 
Nortel Networks technical support 
representative for assistance.

201i server: Check the power supply.

44 Ensure that the slot the 201i server is in is 
receiving power by temporarily plugging in 
a working switch card.

45 If the card does not receive power, then the 
switch backplane may be defective.

AI Replace the switch.

201i server: Check the card slot.

46 Move the 201i server to a working card 
slot.

47 If the 201i server startup begins 
successfully but fails before completion, 
the switch backplane may be defective.

AJ Replace the switch.

201i server: Check the 201i server hex display.

48 If the green hex display at the bottom of the 
201i server faceplate is not lit, the 201i 
server may be defective.

49 During startup, if the hex display shows 
T:00 - T:17 or F:00-F:17 at any time, then 
the 201i server may be defective.

AK Replace the 201i server. Contact your 
Nortel Networks technical support 
representative for assistance.

201i server: Check the dongle.

50 If F:10 is briefly displayed, the dongle may 
not be present or may be defective.

AL Replace the dongle.

Symptom 1: CallPilot server fails to start (no message)

Diagnostic steps Resolution
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201i server: Check the hard drive.

51 Remove and insert the 201i server, and 
jump into the BIOS by hitting F2. Within 
the BIOS, auto-detect the hard drives. If the 
drive is successfully auto-detected it 
indicates that the drive and its cables are 
working and connected properly and you 
should skip out of this section.

52 Remove the 201i server from the switch.

53 Remove the daughterboard from the 
motherboard. 

54 Leave the hard drive power cable connected 
from the motherboard to the hard drive. 

55 Ensure that the hard drive data cable is 
disconnected from the daughterboard. 

56 Reinsert the 201i server and listen carefully 
for the hard disk spin-up cycle. If the disk 
does not spin then the hard disk drive may 
be defective.

57 Remove the 201i server and connect the 
ribbon cable, ensuring that the red stripe on 
the ribbon cable is facing the power cable.

AM Replace the hard drive.

201i server: Check the server.

58 Reinsert the daughterboard into the 
motherboard and fasten the four mounting 
screws.

59 Reinsert the 201i server into the switch.

60 If the 201i server fails to start, the server 
may be defective.

AN Replace the 201i server. Contact your 
Nortel Networks technical support 
representative for assistance.

Symptom 1: CallPilot server fails to start (no message)

Diagnostic steps Resolution
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Symptom 2: The server fails to start (BIOS abnormal device message)

Diagnostic steps Resolution

Check the BIOS settings.

1 Check the NVRAM/BIOS/SSU settings.

2 If the BIOS displays a message regarding a 
peripheral or other device that seems to be 
abnormal, then the NVRAM may have 
been corrupted, or the BIOS/SSU settings 
may be incorrect.

A Verify that you have the latest BIOS 
revision.

B Clear the NVRAM.

C Ensure that all BIOS settings are 
correct.

201i server:

� Restart the 201i server and press F2 to enter 
the BIOS setup.

� Select “Get Default Values” from the Exit 
menu.

� Select Save Changes and Exit, then restart.

702t server: 

Refer to CallPilot Installation and 
Configuration, Part 5: 702t Server Maintenance 
and Diagnostics, “Upgrading and configuring 
the BIOS” in “SSU AND BIOS.” 

1001rp server: 

Refer to CallPilot Installation and 
Configuration, Part 5: 1001rp Server 
Maintenance and Diagnostics, “Upgrading the 
BIOS” in “Maintaining the Pentium II SBC 
card” or “Configuring the 1001rp Pentium III 
BIOS” in “Maintaining the Pentium III SBC 
card.”

1002rp server: 

Refer to CallPilot Installation and 
Configuration, Part 5: 1002rp Server 
Maintenance and Diagnostics, “Configuring the 
1002rp Pentium III BIOS” in “Maintaining the 
Pentium III SBC card.”

3 Does the problem still exist? D Contact your Nortel Networks 
technical support representative for 
assistance.
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Symptom 3: The server fails to start (beep codes are generated)

Diagnostic steps Resolution

Check hardware components and cabling.

1 If beep codes are generated while the server 
is starting, at least one hardware component 
is not connected or is malfunctioning.

2 Check the following components:

� memory modules

� keyboard and mouse connections

� all internal cables 

� all peripheral card seatings

Refer to the documentation for your server:

� CallPilot Installation and 
Configuration, Part 2: 201i Server 
Hardware Installation, “Connecting 
peripheral devices to the 201i server”

� CallPilot Installation and 
Configuration, Part 2: 702t Server 
Hardware Installation, “Connecting 
peripherals to the server”

� CallPilot Installation and 
Configuration, Part 5: 702t Server 
Maintenance and Diagnostics, 
“Replacing baseboard DIMMs”

� CallPilot Installation and 
Configuration, Part 2: 1001rp Server 
Hardware Installation, “Connecting 
peripherals to the server”

� CallPilot Installation and 
Configuration, Part 5: 1001rp Server 
Maintenance and Diagnostics, “Dual 
Inline Memory Modules"

� CallPilot Installation and 
Configuration, Part 2: 1002rp Server 
Hardware Installation, “Connecting 
peripherals to the server” in “Installing 
the server and connecting the peripheral 
devices”

A Contact your Nortel Networks 
technical support representative for 
assistance.
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Check hardware components and cabling 
(continued).

� CallPilot Installation and 
Configuration, Part 5: 1002rp Server 
Maintenance and Diagnostics, 
“Replacing or adding Dual Inline 
Memory Modules” in “Maintaining the 
Pentium III SBC card”

Note: Pay particular attention to the Ethernet and video 
cards. See “Symptom 1: CallPilot server fails to start 
(no message)” on page 14.

See the previous page.

Symptom 3: The server fails to start (beep codes are generated)

Diagnostic steps Resolution
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Symptom 4: The server fails to start (BIOS cannot identify hard disks)

Diagnostic steps Resolution

Check all cable connections and SCSI 
terminations.

1 Check all cable connections.

2 If using a SCSI hard drive, check the 
termination setting on each device and 
verify that the settings are unique.

A Correct the SCSI termination 
settings. Refer to the documentation 
for your server:

� CallPilot Installation and 
Configuration Part 2: 201i 
Server Hardware Installation, 
“Setting the CD-ROM drive's 
SCSI ID and DIP switches” and 
“Setting the tape drive's SCSI 
ID” in “Preparing peripheral 
devices” as well as “Setting SCSI 
device termination”

� CallPilot Installation and 
Configuration, Part 5: 702t 
Server Maintenance and 
Diagnostics, “Replacing or 
installing hard drives” in 
“Replacing the hard drive, tape 
drive, CD-ROM drive, or floppy 
drive”

� CallPilot Installation and 
Configuration, Part 5: 1001rp 
Server Maintenance and 
Diagnostics, “Replacing a hard 
drive” and “Installing a tape 
drive” in “Replacing a hard drive, 
tape drive, CD-ROM drive, or 
floppy drive”

� CallPilot Installation and 
Configuration, Part 5: 1001rp 
Server Maintenance and 
Diagnostics, “Replacing a tape, 
CD-ROM, or floppy drive” in 
“Replacing a hard drive, tape 
drive, CD-ROM drive, or floppy 
drive”

702t server: Check SCSI terminators.

3 Restart the server. If the SCSI hard disk is 
still not identified by the BIOS, then SCSI 
terminators may be defective.

B Replace any SCSI terminators that 
are missing, have an odor, or a have 
small pea-size bulge on any surface.

C Verify the all SCSI device IDs.
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702t server: Check SCSI terminators (continued). D Refer to CallPilot Installation and 
Configuration, Part 5: 702t Server 
Maintenance and Diagnostics, 
“Replacing or installing hard drives” 
in “Replacing the hard drive, tape 
drive, CD-ROM drive, or floppy 
drive.”

702t or 1001rp server: Check the RAID subsystem.

4 If your system has RAID, the RAID 
configuration may have an error.

5 Check the RAID configuration.

E Refer to the documentation for your 
server:

� CallPilot Installation and 
Configuration, Part 5: 702t 
Server Maintenance and 
Diagnostics, “Configuring an 
AcceleRAID352 RAID system” 
in “Maintaining an 
AcceleRAID352 RAID system”

� CallPilot Installation and 
Configuration, Part 5: 702t 
Server Maintenance and 
Diagnostics, “Configuring a 
DAC960 RAID system” in 
“Maintaining a DAC960 RAID 
system”

� CallPilot Installation and 
Configuration, Part 5: 1001rp 
Server Maintenance and 
Diagnostics, “Configuring an 
AcceleRAID352 RAID system” 
in “Maintaining an 
AcceleRAID352 RAID system”

� CallPilot Installation and 
Configuration, Part 5: 1001rp 
Server Maintenance and 
Diagnostics, “Configuring a 
DAC960 RAID system” in 
“Maintaining a DAC960 RAID 
system”

Symptom 4: The server fails to start (BIOS cannot identify hard disks)

Diagnostic steps Resolution
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702t server: Check the SCSI interface.

6 While the system is starting, verify that the 
SCSI message identifying the tape drive on 
the SCSI bus appears.

7 If the message does not appear, then there 
may be a problem with the tape drive’s 
SCSI interface.

8 Examine the 702t system for a proper 
connection from the main board to the tape 
drive, and then to the SCSI terminator.

F Refer to CallPilot Installation and 
Configuration, Part 5: 702t Server 
Maintenance and Diagnostics, “SCSI 
and IDE cabling illustrations” in 
“Replacing the hard drive, tape drive, 
CD-ROM drive, or floppy drive.”

9 Does the problem still exist? G Contact your Nortel Networks 
technical support representative for 
assistance.

Symptom 4: The server fails to start (BIOS cannot identify hard disks)

Diagnostic steps Resolution
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Symptom 5: The server starts but the tape drive does not function

Diagnostic steps Resolution

Check tape drive installation.

1 If the system starts and the tape drive is still 
not operational, then the tape drive may 
have to be re-installed through the 
operating system.

A Re-install the tape drive through the 
operating system. Refer to the 
documentation for your server:

� MAS 702t Installation and 
Maintenance Guide, “Installing 
the tape device driver” in 
“Performing software installation 
and configuration”

� MAS 1001rp Installation and 
Maintenance Guide, “Installing 
the tape device driver” in 
“Performing software 
maintenance”

� MAS 201i Installation and 
Maintenance Guide, “To install 
the tape drive driver” in “Hard 
disk recovery and build”

Defective tape drive.

2 If tape drive errors persist, then there may 
be defect in the SCSI tape drive.

B Replace the tape drive unit.

3 Does the problem still exist? C Contact your Nortel Networks 
technical support representative for 
assistance.
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Symptom 6: Server unable to boot into NT

Diagnostic steps Resolution

1 You are experiencing a problem booting 
NT because one of the files (boot.ini, 
NTLDR or NTDETECT.COM) is missing 
or corrupted.

Tower or rackmount server only:

A If the system has DOS, BOOT into 
DOS. If the system is newer, it will 
not have DOS installed and you will 
need to boot from a floppy disk.

B If you don’t have the boot floppy, 
create it by Create a Boot Floppy 
from another NT OS:

� Open My Computer and select 
the floppy icon.

� Place a blank floppy in the disk 
drive.

� Select File > Format; click Start 
to format the floppy.

� Click OK to continue and then 
OK to Format

� Copy boot.ini, NTLDR and 
NTDETECT.COM from your 
hard disk to your floppy disk.

C Copy boot.ini, NTLDR and 
NTDETECT.COM from a floppy to 
your system.

201i server:

A Insert the PC-CIA Flash card and 
boot the system.

B Check to see if the file BOOT.INI is 
in the root of the C: drive. If it does 
not proceed to step C.

C From the DOS window, go to drive 
C: and create a new BOOT.INI file 
using EDIT. BOOT.INI should be in 
the root directory of C:
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2 Windows NT could not start because the 
following file is missing or corrupted: \ 
<winnt root>\system32\ntoskrnl.exe. 
Please reinstall a copy of the above file.

Tower or rackmount server only

D Boot.ini is missing or directs the OS 
to wrong partition (see above for 
details on how to boot system). Boot 
NT from the boot floppy and correct 
boot.ini file.

E If ntoskrnl.exe is damaged, use the 
three Windows NT installation 
diskettes, NT CD-ROM and the 
repair diskette. 

3 Does the problem still exist? F Contact your Nortel Networks 
technical support representative for 
assistance.

Symptom 6: Server unable to boot into NT

Diagnostic steps Resolution
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Symptom 7: The screen image moves back and forth (201i server only)

Diagnostic steps Resolution

201i server: Check modem DIP switch settings.

1 Verify the modem DIP switch settings. 
Refer to CallPilot Installation and 
Configuration, Part 2: 201i Server 
Hardware Installation, “Setting the modem 
DIP switches” in “Preparing peripheral 
devices.”

A Correct the DIP switch settings. The 
correct settings are: 1-OFF, 2-OFF, 3-
ON, 4-ON, 5-ON, 6-OFF, 7-OFF, and 
8-ON.

2 Does the problem still exist? B Contact your Nortel Networks 
technical support representative for 
assistance.
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Symptom 8: The 201i server restarts randomly and unpredictably

Diagnostic steps Resolution

201i server: Check motherboard.

1 Remove the four screws holding down the 
NTRH13BA daughterboard.

2 Remove the daughterboard from the 
motherboard.

3 Locate device U61 found on the 
motherboard, near the center of the PCB, 
beside another component labeled "Lattice" 
(the component name is DS1232S).

4 If the date code is followed by "C2" (for 
example, 9922C2) then the 201i server is 
defective.

A Replace the 201i server. Contact your 
Nortel Networks technical support 
representative for assistance.
Troubleshooting Reference 31



Hardware troubleshooting Standard 1.0
Symptom 9: Error message "Can’t find Cirrus Logic PCMCIA controller..."
interrupts CallPilot installation (201i server only)

Diagnostic steps Resolution

201i server: Bypass startup errors.

Note: Although the 201i server is malfunctioning, you 
can continue the CallPilot installation:

1 Hold down the ALT key to bypass the 
halting and proceed with Windows NT 
logon.

2 Proceed with CallPilot installation.

A Contact your Nortel Networks 
technical support representative to 
report the error.

201i server: Check the SCSI peripherals.

3 Remove the 201i server from the switch.

4 Unplug all SCSI peripherals such as the 
tape drive and CD-ROM drive from the 
cable.

5 Reinsert the 201i server in the slot.

6 If the 201i server functions as expected, a 
SCSI peripheral device may be defective.

B Identify the defective SCSI 
peripheral by re-attaching one 
peripheral at a time until the 
defective component is found.

C Replace the defective peripheral. 
Refer to CallPilot Installation and 
Configuration, Part 2: 201i Server 
Hardware Installation, “Preparing 
peripheral devices.”

201i server: Check the SCSI cable.

7 Remove the 201i server from the switch.

8 Unplug the SCSI cable from the 201i 
server’s faceplate.

9 Reinsert the 201i server in the slot.

10 If the 201i server functions as expected, the 
SCSI cable may be defective.

D Verify the cable's NT or A0# product 
code and replace the defective cable.

E Refer to CallPilot Installation and 
Configuration, Part 2: 201i Server 
Hardware Installation, “Installing the 
SCSI cables for Meridian 1.”

11 Does the problem still exist? F Contact your Nortel Networks 
technical support representative for 
assistance.
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Symptom 10: System fails to boot (boots to a blue screen or freezes)

Diagnostic steps Resolution

Check all external and internal cabling. 

1 Disconnect, reconnect, and check for 
damage to the cabling, including:

� 201i server: Check the cabling for the 
following: CD-ROM and tape drive 
cabling, SCSI faceplate, hard drive, 
motherboard and SCSI paddleboard, 
internal and external Ethernet and 
Token Ring, power supply, modem, and 
breakout box cabling.

� 702t or 1001rp: Check the power cords 
and cabling for the following: RAID, 
floppy drive, CDROM and tape drives, 
SCSI faceplate, hard drive, 
motherboard and SCSI paddleboard, 
internal and external Ethernet and 
Token Ring, power supply, Modem, and 
breakout box.

2 Restart the server. If the blue screen no 
longer appears, at least one cable was 
missing, improperly connected, or 
damaged.

A Try starting in VGA MODE by 
selecting the third operating system 
from the list displayed after startup.

B Try using the "Last known good 
menu" by pressing the space bar 
immediately before Windows NT 
begins to start. 

C If cables were improperly connected, 
ensure that all cable connectors are 
undamaged and dust-free. 

D If cables are missing or damaged, 
order the appropriate cables and/or 
devices and replace them.

Check SCSI Termination - STOP CODES: 77, 7A, 
7B

3 If the server has SCSI devices, ensure that 
each SCSI device in the chain has the 
correct termination settings and that the 
entire chain has been terminated properly 
by a non-defective terminator.

4 If a device’s SCSI termination jumpers have 
been set incorrectly, or, the SCSI terminator 
is missing or defective, then a SCSI 
termination problem exists.

E Replace any SCSI terminators that 
are missing, have an odor, or have a 
small pea-size bulge on any of their 
surfaces.

F Set the termination jumpers of all 
SCSI devices to their correct values. 
Refer to the documentation for your 
server:

� CallPilot Installation and 
Configuration, Part 2: 201i 
Server Hardware Installation, 
“Setting SCSI device 
termination”
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Check SCSI Termination - STOP CODES: 77, 7A, 
7B (continued)

� CallPilot Installation and 
Configuration, Part 5: 702t 
Server Maintenance and 
Diagnostics, “Replacing or 
installing hard drives” in 
“Replacing the hard drive, tape 
drive, CD-ROM drive, or floppy 
drive”

� CallPilot Installation and 
Configuration, Part 5: 1001rp 
Server Maintenance and 
Diagnostics, “Replacing a hard 
drive” and “Installing a tape 
drive” in “Replacing a hard drive, 
tape drive, CD-ROM drive, or 
floppy drive”

� CallPilot Installation and 
Configuration, Part 5: 1002rp 
Server Maintenance and 
Diagnostics, “Replacing a tape, 
CD-ROM, or floppy drive” in 
“Replacing a hard drive, tape 
drive, CD-ROM drive, or floppy 
drive”

Check SCSI IDs - STOP CODES: 77, 7A, 7B

5 If the server uses SCSI devices, ensure that 
each SCSI device in the chain has its SCSI 
ID set to the correct value.

6 If a device's SCSI ID is not set to its correct 
value then a SCSI ID problem exists.

G Set the SCSI ID jumpers/switches of 
all SCSI devices to their correct 
values.

Check memory - STOP CODES: 1A, 2C, 2D, 2E, 7D 

7 Remove all memory modules from the 
server and verify the memory module part 
numbers. Do this by recording the 
manufacturers' part numbers and 
comparing them against a list of supported 
parts for the server.

8 If part numbers do not match exactly, the 
memory may be substandard, causing a 
blue screen.

H Contact your Nortel Networks 
technical support representative for 
assistance for the latest approved 
memory products.

Symptom 10: System fails to boot (boots to a blue screen or freezes)

Diagnostic steps Resolution
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Check the memory modules. 

9 Remove the memory modules and ensure 
that their connectors are dust free, and 
reinsert them in the motherboard. Refer to 
the documentation for your server:

� CallPilot Installation and 
Configuration, Part 5: 702t Server 
Maintenance and Diagnostics, 
“Replacing baseboard DIMMs”

� CallPilot Installation and 
Configuration, Part 5: 1001rp Server 
Maintenance and Diagnostics, “Dual 
Inline Memory Modules” in 
“Maintaining the Pentium II SBC Card” 
or “Replacing or adding Dual Inline 
Memory Modules” in “Maintaining the 
Pentium III SBC card”

� CallPilot Installation and 
Configuration, Part 5: 1002rp Server 
Maintenance and Diagnostics, 
“Replacing or adding Dual Inline 
Memory Modules” in “Maintaining the 
Pentium III SBC card”

10 Restart the server. If the blue screens no 
longer appear, then at least one memory 
module may have been improperly seated.

I Reseat the memory module.

J Ensure that the memory module 
latches on the motherboard are closed 
securely.

Isolate the memory modules.

11 Remove one or more memory modules so 
that only a single module remains in the 
server. Alternatively, replace all of the 
memory modules with new modules.

12 Restart the server. If the blue screens no 
longer appear, then at least one memory 
module may be defective.

K Replace all of the memory modules.

Symptom 10: System fails to boot (boots to a blue screen or freezes)

Diagnostic steps Resolution
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702t, 1001rp, or 1002rp server: Check processor - 
STOP CODES: 1A, 1E, 3E, 79, 92, 9C

13 Remove all CPUs from the server, ensure 
that their connectors are dust free, and 
reinsert them in the motherboard. Refer to 
the documentation for your server:

� CallPilot Installation and 
Configuration, Part 5: 702t Server 
Maintenance and Diagnostics, 
“Replacing the CPU” in “Replacing 
DIMMs and the CPU”

� CallPilot Installation and 
Configuration, Part 5: 1001rp Server 
Maintenance and Diagnostics, 
“Replacing the Pentium II SBC card” in 
“Maintaining the Pentium II SBC card” 
or “Replacing the Pentium III SBC 
card” in “Maintaining the Pentium III 
SBC card”

� CallPilot Installation and 
Configuration, Part 5: 1002rp Server 
Maintenance and Diagnostics, 
“Replacing the Pentium III SBC card” 
in “Maintaining the Pentium III SBC 
card”

14 Restart the server. If the blue screens no 
longer appear, then at least one processor 
may have been improperly seated.

L Remove and reseat all processors.

M Ensure that the processor SLOT1/
Socket370 latches are closed securely 
on the motherboard.

702t server: Check processors.

15 In a multiprocessor system, check the type 
and stepping version of all processors to 
ensure that they match. Refer to CallPilot 
Installation and Configuration, Part 5: 
702t Server Maintenance and Diagnostics, 
“Replacing the CPU” in “Replacing 
DIMMs and the CPU.”

16 If any processors are missing, or if all 
processors are not identical, then at least 
one processor may be missing or be the 
incorrect type.

N Replace the missing or mismatched 
processors with new ones.

Symptom 10: System fails to boot (boots to a blue screen or freezes)

Diagnostic steps Resolution
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Check I/O card locations.

17 Ensure that all PCMCIA cards, ISA cards, 
and PCI cards have been inserted into their 
correct slot assignments. Refer to the 
documentation for your server:

� CallPilot Installation and 
Configuration, Part 2: 702t Server 
Hardware Installation, “Slot 
assignments” in “702t server 
description”

� CallPilot Installation and 
Configuration, Part 2: 1001rp Server 
Hardware Installation, “Slot 
assignments” in “1001rp server 
description”

� CallPilot Installation and 
Configuration, Part 2: 201i Server 
Hardware Installation, “Installing the 
MPCs” in “Connecting peripheral 
devices to the 201i server”

� CallPilot Installation and 
Configuration, Part 2: 1002rp Server 
Hardware Installation, “Slot 
assignments” in “1002rp server 
description”

18 If the cards are located in their incorrect 
slot assignment, then the system may be 
unstable due to incorrect I/O card locations.

O Move all PCMCIA, ISA, and PCI 
cards to their correct slot locations.

P 702t server: Use the SSU BIOS 
configuration disks to ensure that the 
slot interrupt mappings are also 
correct.

Check CD-ROM drive cabling.

19 If you have a 201i server, and both the 
CD-ROM and the tape drive connected, 
ensure that the CD-ROM drive is connected 
first followed by the tape drive.

20 If you have a 201i server and both a 
CD-ROM and a tape drive, and only the 
CD-ROM drive can be seen, check to see 
that termination is disabled on the 
CD-ROM.

21 Remove and detach the CD-ROM drive 
from the server.

Continued on next page.

Q Verify the CD-ROM drive cabling 
and power cabling.

R Replace the CD-ROM cable. Refer to 
the documentation for your server:

� CallPilot Installation and 
Configuration, Part 2: 201i 
Server Hardware Installation, 
“Preparing peripheral devices”

Symptom 10: System fails to boot (boots to a blue screen or freezes)

Diagnostic steps Resolution
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Check CD-ROM drive cabling (continued).

22 If SCSI, ensure that the remaining devices 
are terminated properly.

23 Restart the server. If the blue screens no 
longer appear, then the CD-ROM drive, its 
cabling, or its termination or SCSI ID (if 
applicable) may be defective or incorrect.

� CallPilot Installation and 
Configuration, Part 5: 702t 
Server Maintenance and 
Diagnostics, “SCSI and IDE 
cabling illustrations” in 
“Replacing the hard drive, tape 
drive, CD-ROM drive, or floppy 
drive”

� CallPilot Installation and 
Configuration, Part 5: 1001rp 
Server Maintenance and 
Diagnostics, “Replacing a tape, 
CD-ROM, or floppy drive” in 
“Replacing a hard drive, tape 
drive, CD-ROM drive, or floppy 
drive”

� CallPilot Installation and 
Configuration, Part 5: 1002rp 
Server Maintenance and 
Diagnostics, “Replacing a tape, 
CD-ROM, or floppy drive” in 
“Replacing a hard drive, tape 
drive, CD-ROM drive, or floppy 
drive”

Check CD-ROM drive.

24 Verify the CD-ROM termination jumper 
settings (if SCSI).

25 Verify the CD-ROM is terminated properly 
(if SCSI).

26 Verify the CD-ROM has the correct SCSI 
ID (if SCSI).

S Replace the CD-ROM drive. 

Check the tape drive cabling and configuration.

27 Remove and detach the tape drive from the 
server.

28 If SCSI, ensure that the remaining devices 
are terminated properly.

29 Restart the server. If the blue screens no 
longer appear, then the tape drive, its 
cabling, its termination, or its SCSI ID may 
be defective or incorrect.

T Replace the tape drive cable. Refer to 
the documentation for your server:

� CallPilot Installation and 
Configuration, Part 2: 201i 
Server Hardware Installation, 
“Connecting the CD-ROM and 
tape drives” in “Connecting 
peripheral devices to the 201i 
server”

Symptom 10: System fails to boot (boots to a blue screen or freezes)

Diagnostic steps Resolution
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Check the tape drive cabling and configuration 
(continued).

� CallPilot Installation and 
Configuration, Part 5: 702t 
Server Maintenance and 
Diagnostics, “SCSI and IDE 
cabling illustrations” in 
“Replacing the hard drive, tape 
drive, CD-ROM drive, or floppy 
drive”

� CallPilot Installation and 
Configuration, Part 5: 1001rp 
Server Maintenance and 
Diagnostics, “Replacing a tape, 
CD-ROM, or floppy drive” in 
“Replacing a hard drive, tape 
drive, CD-ROM drive, or floppy 
drive”

� CallPilot Installation and 
Configuration, Part 5: 1002rp 
Server Maintenance and 
Diagnostics, “Replacing a tape, 
CD-ROM, or floppy drive” in 
“Replacing a hard drive, tape 
drive, CD-ROM drive, or floppy 
drive”

Check the tape drive.

30 Verify the tape drive cabling and power 
cabling.

31 Verify the tape drive termination jumper 
settings (if SCSI).

32 Verify the tape drive is terminated properly 
(if SCSI).

33 Verify the tape drive has the correct SCSI 
ID (if SCSI).

U Replace the tape drive.

Check the modem cabling.

34 Remove and detach the modem from the 
server/breakout box.

35 Restart the server. If the blue screens no 
longer appear, then the modem or its 
cabling may be defective or incorrect.

V Replace the modem serial cable.

Symptom 10: System fails to boot (boots to a blue screen or freezes)

Diagnostic steps Resolution
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Check the modem (if applicable).

36 Verify the modem serial cabling and power 
cabling. Refer to the documentation for 
your server:

� CallPilot Installation and 
Configuration, Part 2: 201i Server 
Hardware Installation, “Connecting the 
modem” in “Connecting peripheral 
devices to the 201i server”

� CallPilot Installation and 
Configuration, Part 2: 702t Server 
Hardware Installation, “Preparing the 
modem” in “Installing the server and 
connecting the peripheral devices”

� CallPilot Installation and 
Configuration, Part 2: 1001rp Server 
Hardware Installation, “Preparing the 
modem” in “Installing the server and 
connecting the peripheral devices”

� CallPilot Installation and 
Configuration, Part 2: 1002rp Server 
Hardware Installation, “Preparing the 
modem” in “Installing the server and 
connecting the peripheral devices”

37 Replace the modem serial cable with a 
known good cable.

W Replace the modem.

702t or 1001rp server: Check the BIOS settings.

38 Verify all of the BIOS settings including 
IRQ, memory, and DMA assignments. For 
the 702t server, use the SSU disks.

39 Restart the server. If the blue screens no 
longer appear, then the BIOS settings may 
have been incorrect.

X Change the BIOS settings to the 
correct values. Refer to the 
documentation for your server:

� CallPilot Installation and 
Configuration, Part 5: 702t 
Server Maintenance and 
Diagnostics, “Upgrading and 
configuring the BIOS” and 
“Configuring your system using 
SSU” in “SSU and BIOS”

Symptom 10: System fails to boot (boots to a blue screen or freezes)

Diagnostic steps Resolution
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702t or 1001rp server: Check the BIOS settings 
(continued)

� CallPilot Installation and 
Configuration, Part 5: 1001rp 
Server Maintenance and 
Diagnostics, “Upgrading the 
BIOS” in “Maintaining the 
Pentium II SBC card” or 
“Configuring the 1001rp Pentium 
III BIOS” in “Maintaining the 
Pentium III SBC card”

� CallPilot Installation and 
Configuration, Part 5: 1002rp 
Server Maintenance and 
Diagnostics, “Configuring the 
1002rp Pentium III BIOS” in 
“Maintaining the Pentium III 
SBC card”

702t, 1001rp, or 1002rp server: Check the ELAN 
card internal cabling.

40 Remove the ELAN ISA/PCI network 
interface card and restart the server.

41 If the blue screens no longer appear, then 
the ELAN network interface card or its 
cabling may be configured incorrectly or is 
defective.

42 Restart the system without the network card 
and verify that the IRQ, I/O ports, and other 
network interface software parameters have 
been set correctly.

43 If the parameters are correct, ensure that the 
ELAN network interface card is inserted 
into its correct ISA/PCI slot. 
702t server: Use the SSU BIOS 
configuration disks to ensure that the slot 
interrupt mappings are correct.

Y Replace any network interface card 
internal cabling.

Z Replace the network interface card. 
Refer to the documentation for your 
server:

� CallPilot Installation and 
Configuration, Part 2: 702t 
Server Hardware Installation, 
“Connecting the server to the 
ELAN” in “Installing the server 
and connecting the peripheral 
devices”

� CallPilot Installation and 
Configuration, Part 2: 1001rp 
Server Hardware Installation, 
“Connecting the server to the 
ELAN” in “Installing the server 
and connecting the peripheral 
devices”

� CallPilot Installation and 
Configuration, Part 2: 1002rp 
Server Hardware Installation, 
“Connecting the server to the 
ELAN” in “Installing the server 
and connecting the peripheral 
devices”

Symptom 10: System fails to boot (boots to a blue screen or freezes)

Diagnostic steps Resolution
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Check the CLAN card.

44 Remove the CLAN PCMCIA/ISA/PCI 
network interface card and restart the 
server.

45 If the blue screens no longer appear, then 
the CLAN card or its cabling may be 
configured incorrectly or defective.

46 Restart the system without the network card 
and ensure that the IRQ, I/O ports, and 
other network interface software 
parameters have been set correctly.

47 If the parameters are correct, ensure that the 
CLAN card is inserted into it correct 
PCMCIA/ISA/PCI slot.

48 702t server: Use the SSU BIOS 
configuration disks to ensure that the slot 
interrupt mappings are correct.

AA Replace the internal cabling, if any, 
on the network interface card.Refer 
to the documentation for your server:

� CallPilot Installation and 
Configuration, Part 2: 702t 
Server Hardware Installation, 
“Connecting the server to the 
CLAN (optional)” in “Installing 
the server and connecting the 
peripheral devices”

� CallPilot Installation and 
Configuration, Part 2: 1001rp 
Server Hardware Installation, 
“Connecting the server to the 
CLAN (optional)” in “Installing 
the server and connecting the 
peripheral devices”

� CallPilot Installation and 
Configuration, Part 2: 1002rp 
Server Hardware Installation, 
“Connecting the server to the 
CLAN (optional)” in “Installing 
the server and connecting the 
peripheral devices”

AB Replace the network interface card:

� PCI 10Mb Ethernet Adapter 
(NTRH9009)

� PCI 100Mb Ethernet Adapter 
(NTRH9036)

� ISA 10Mbps Ethernet Adapter 
(NTRH9047)

Symptom 10: System fails to boot (boots to a blue screen or freezes)

Diagnostic steps Resolution
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Check the multimedia processing cards and 
sockets.

49 Remove all multimedia processing cards 
from all MPBs/201i in the platform.

50 Restart the server. If the blue screens no 
longer appear, then at least one card or 
socket may be defective.

51 Isolate a card problem by inserting each 
card one at a time and rebooting.

52 Determine if multimedia processing cards 
or sockets are defective by using good 
cards in questionable sockets and inserting 
questionable cards into good sockets.

AC Depending on whether cards or 
sockets are defective, replace the 
cards, sockets, and/or the MPB/201i 
accordingly. Refer to the 
documentation for your server:

� CallPilot Installation and 
Configuration, Part 5: 201i 
Server Maintenance and 
Diagnostics, “Replacing 
Multimedia Processing Cards” in 
“Performing hardware 
maintenance and mechanical 
assembly”

� CallPilot Installation and 
Configuration, Part 5: 702t 
Server Maintenance and 
Diagnostics, “Replacing or 
adding voice processing boards”

� CallPilot Installation and 
Configuration, Part 5: 1001rp 
Server Maintenance and 
Diagnostics, “Replacing or 
adding voice processing boards”

� CallPilot Installation and 
Configuration, Part 5: 1002rp 
Server Maintenance and 
Diagnostics, “Replacing or 
adding voice processing boards”

702t and 1001rp server: Check the multimedia 
processing boards.

53 Remove all multimedia processing boards 
from the platform.

54 Restart the server and if the blue screens no 
longer occur then at least one board may be 
defective or the server may be defective or 
incorrectly configured.

55 Ensure that the multimedia processing 
boards are inserted into their correct PCI 
slots.

Continued on the next page.

AD Depending on whether MPBs or the 
server is defective, replace the 
appropriate components accordingly.

Symptom 10: System fails to boot (boots to a blue screen or freezes)

Diagnostic steps Resolution
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702t and 1001rp server: Check the multimedia 
processing boards (continued)

56 702t server: Use the SSU BIOS 
configuration disks to ensure that the slot 
interrupt mappings are also correct.

57 Determine whether MPBs or PCI slots are 
defective by using known-good MPBs in 
questionable PCI slots, and questionable 
MPBs in known-good PCI slots.

See the previous page.

Check hard disk drive(s) for corruption - MISC 
STOP CODES

58 If the server was shutdown improperly or 
was subject to a power loss, then the hard 
drive may have been corrupted.

59 Check the hard drive cabling.

60 Check for physical hard drive damage.
702t or 1001rp server: 

� If a recent emergency repair disk is 
available, use it with the Windows NT 
startup disks to repair the hard disk. 

� If a recent emergency repair disk is not 
available, attempt repair using the 
Windows NT startup disks.

AE Rebuild the hard drive and reinstall 
the operating system and all CallPilot 
software.
Note: To prevent future occurrences 
of corruption, follow proper 
shutdown procedures and consider 
purchasing an uninterruptible power 
supply (UPS).

201i server: Check cables and peripherals.

61 Shut down the server and remove the power 
unit. Unplug all external cables (such as the 
NTRH0910/NTRH0911 breakout cable and 
the applicable SCSI faceplate cable) and 
peripherals.

62 Identify the defective cable by connecting 
one external cable at a time and restarting 
the server after each connection. 

63 Identify any defective peripherals by 
connecting one at a time and restarting the 
server after each connection.

64 Restart the server.

65 Does the problem still exist?

AF Conduct memory diagnostics.

Symptom 10: System fails to boot (boots to a blue screen or freezes)

Diagnostic steps Resolution
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Conduct memory diagnostics.

66 Restart the server and select DOS from the 
three-option startup menu.

67 Execute PCDiags and review test logs for 
failures. Refer to the documentation for 
your server:

� MAS 702t Installation and Maintenance 
Guide, “Running PCDiags” in 
“Troubleshooting”

� MAS 1001rp Installation and 
Maintenance Guide, “Running 
PCDiags” in “Diagnostics”

� MAS 201i Installation and Maintenance 
Guide, “Working with PCDiags” in 
“Troubleshooting and diagnostics”

AG If any memory tests fail, replace the 
defective memory module.

68 Does the problem still exist? AH Contact your Nortel Networks 
technical support representative for 
assistance.

Symptom 10: System fails to boot (boots to a blue screen or freezes)

Diagnostic steps Resolution
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Symptom 11: Modem does not function

Diagnostic steps Resolution

Conduct modem sanity check.

1 Verify that the modem is a Nortel 
Networks-approved US Robotics product.

2 Verify that red LEDs are illuminated on the 
modem faceplate.

3 If no red LEDs are lit then the modem may 
not be receiving power.

A Ensure the unit is properly plugged in 
to the wall AC outlet.

Check cabling and DIP switch settings.

4 Ensure that the modem cable is properly 
connected to the server COM port or 
NTRH09AA breakout box at both ends of 
the cable and in its designated COM port.

5 Verify the DIP switch settings. The settings 
for each switch are: 1-OFF, 2-OFF, 3-ON, 
4-ON, 5-ON, 6-OFF, 7-OFF, and 8-ON.

6 The modem will operate abnormally or not 
all if the DIP switch settings are incorrect 
or serial cable connection is not fully 
secured. 

B Check the telephone connection.

C Correct the DIP switch settings.

Check the telephone connection.

7 Verify that the RJ45 telephone cable is 
properly connected between the modem’s 
line-in jack and the analog telco telephone 
line. Ensure that the modem’s volume 
control is set in the middle of the selectable 
range. If you do not hear a dial tone while 
dialing a phone number, then it is likely that 
your analog telephone connection not 
connected.

D Consult local technical staff to ensure 
the correct jack is being used and is 
properly connected to the public 
analog telephone system.

Check console redirection settings.

8 Verify the BIOS console redirection 
settings by entering the BIOS setup. Refer 
to the documentation for your server: 

� MAS 702t Installation and Maintenance 
Guide, “Performing software 
installation and configuration”

� MAS 1001rp Installation and 
Maintenance Guide, “Running 
PCDiags” in “Diagnostics”

E Correct the BIOS redirection settings 
according to the following:

� 201i server: Enabled

� 702t or 1001rp server: Disabled
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Check console redirection settings (continued)

� MAS 201i Installation and Maintenance 
Guide, “Using console redirection” in 
“Troubleshooting and diagnostics”

The modem will operate abnormally or not all if the 
BIOS console redirection settings are incorrect.

See the previous page.

Determine if multiple software programs (such as 
RAS, pcAnywhere, Windows NT or HyperTerminal) 
are accessing the modem.

9 Press Ctrl-Alt-Del to access the Task 
Manager. Note which programs are active. 
Only one software program can access the 
COM port.

10 If more then one program is accessing the 
COM port then you may suffer from a 
software contention issue.

F Use the Windows NT Task Manager 
to exit other programs that are using 
the COM port.

11 Does the problem still exist? G Contact your Nortel Networks 
technical support representative for 
assistance.

Symptom 11: Modem does not function

Diagnostic steps Resolution
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Symptom 12: CD-ROM drive does not function

Diagnostic steps Resolution

Check the CD-ROM.

1 Verify that the CD is properly installed and 
not upside down.

A Eject the CD and ensure that the CD 
label is facing up.

Inspect the CD.

2 Inspect the CD. If it is visibly scratched or 
damaged, the CD may be unusable.

B Insert a CD that is known to be 
working and verify that the server 
can access it.

702t, 1001rp, or 1002rp server: Check CD-ROM 
settings

3 Verify that the CD-ROM LED flashes 
during a startup.

4 The CD-ROM drive may be incorrectly 
configured.

C Check the IDE CD-ROM settings 
from the BIOS. The selection should 
be set for an ATAPI device.

702t, 1001rp, or 1002rp server: Check CD-ROM 
startup messages.

5 The CD-ROM LED still does not flash 
briefly during a startup, or the startup 
screen does not report the following 
message:
ATAPI CDROM: CD-XXXXXXXXXXX 
where XXXXX is the actual model number. 
Note: If you receive this message, then the 
CD-ROM is properly configured in the 
BIOS.

6 The CD-ROM cables may not be correctly 
installed.

D Open the server and verify that the 
internal CD-ROM has the power 
connector and the IDE cable firmly 
connected to the CD-ROM drive and 
the baseboard or SBC. Refer to the 
documentation for your server:

� CallPilot Installation and 
Configuration, Part 5: 702t 
Server Maintenance and 
Diagnostics, “SCSI and IDE 
cabling illustrations” in 
“Replacing the hard drive, tape 
drive, CD-ROM drive, or floppy 
drive”

� CallPilot Installation and 
Configuration, Part 5: 1001rp 
Server Maintenance and 
Diagnostics, “Replacing a tape, 
CD-ROM, or floppy drive” in 
“Replacing a hard drive, tape 
drive, CD-ROM drive, or floppy 
drive”
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702t, 1001rp, or 1002rp server: Check CD-ROM 
startup messages (continued).

� CallPilot Installation and 
Configuration, Part 5: 1002rp 
Server Maintenance and 
Diagnostics, “Replacing a tape, 
CD-ROM, or floppy drive” in 
“Replacing a hard drive, tape 
drive, CD-ROM drive, or floppy 
drive”

201i server: Check SCSI adapter.

7 Verify that the SCSI driver is loaded.

8 In the Control Panel, click SCSI Adapters. 

9 Under the Devices tab, verify that the 
Symbios Logic C… SCSI Host Adapter is 
present.

E If the Symbios SCSI driver is not 
present then there are two options:

� Insert the CallPilot CD into a PC 
on the customer network. Install 
the driver accessing the PC 
through a shared network 
connection using Network 
Neighborhood.

� Replace the 201i server. Contact 
your Nortel Networks technical 
support representative for 
assistance.

201i server: Check SCSI switch settings.

10 Assuming the SCSI tape drive is not 
connected, verify the DIP switch settings 
on the CD-ROM unit.

11 The first two (from the left) are in the up 
position and the rest are in the down 
position.

12 If the DIP switch settings are incorrect then 
termination errors may result in either a 
Windows NT blue screen or incomplete 
CD-ROM operation.

F Correct the DIP switch settings. 
Refer to CallPilot Installation and 
Configuration, Part 2: 201i Server 
Hardware Installation, “Setting the 
CD-ROM drive's SCSI ID and DIP 
switches” in “Preparing peripheral 
devices.”

201i server: Check SCSI termination.

13 If the SCSI tape drive and CD-ROM drive 
are daisy chained together, then the second 
switch (termination) should be in the OFF 
(down) position. 

14 The CD-ROM drive will not work if the 
second DIP switch setting is in the ON (up) 
position. 

G Correct the DIP switch settings. 
Refer to CallPilot Installation and 
Configuration, Part 2: 201i Server 
Hardware Installation, “Setting the 
CD-ROM drive's SCSI ID and DIP 
switches” in “Preparing peripheral 
devices.”

Symptom 12: CD-ROM drive does not function

Diagnostic steps Resolution
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201i server: Check SCSI ID settings.

15 Ensure that the SCSI ID numbers of the 
SCSI tape drive and CD-ROM drive are 
different.
Note: SCSI operation will be unstable or 
inoperable if the SCSI ID numbers are the 
same.

H Change the SCSI ID on one of the 
SCSI units by pressing a button (for 
the tape drive) or rotating a dial (for 
the CD-ROM drive) on the back of 
the SCSI peripheral device.

I Shut down and restart the 201i server.

CD-ROM drive defective.

16 If the CD-ROM is still not recognized by 
the operating system then the CD-ROM 
drive may be defective.

J Replace the CD-ROM drive. Contact 
your Nortel Networks technical 
support representative for assistance.

Symptom 12: CD-ROM drive does not function

Diagnostic steps Resolution
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Symptom 13: Serial ports do not function

Diagnostic steps Resolution

Confirm the ports are enabled in the BIOS.

1 Enter BIOS: Press F2 to enter setup.

2 Use the arrow key to move to the Advanced 
tab.

3 Select I/O Device Configuration and press 
Enter.

4 Select Serial port A, press Enter, and then 
select Enabled.

5 Select Serial port B, press Enter, and then 
select Enabled.

6 Use the arrow key to move to the Exit tab, 
select Exit Saving Changes, and then press 
Enter.

A If the ports are not enabled, enable 
and reboot

If ports are enabled but not recognized.

7 702t, 1001rp, or 1002rp server: There are 
two serial ports on tower and rackmount 
servers. Try reversing the external cables to 
ensure the device is connected to the right 
serial port.

8 If this does not correct the problem, power 
down the server and ensure that the internal 
serial cables are connected correctly. 
Ensure that the cables are connected and 
that the red strip connects to pin 1.

9 If the cables were connected properly, try 
reversing the internal cables. Reboot and 
test again.

B If the ports are enabled in the BIOS 
but are not displayed in the OS boot 
sequence this indicates faulty 
hardware on the motherboard.
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Symptom 14: SCCS unable to de-acquire resources after improper shutdown or crash
The Symposium Call Center Services (SCCS) server acquires devices such as Terminal Numbers (TNs) 
and Automatic Call Distribution (ACD) agent telephone sets on the Meridian 1 and Succession CSE 1000 
switches. If the SCCS server crashes or is shut down without running the shutdown utility, then the 
devices remain acquired and cannot be used by other applications.

Diagnostic steps Resolution

Verify if the SCCS server can de-aquire 
one or more devices.

A Perform a switch SYSLOAD. 

After the switch INIT, verify if the 
Control Directory Number (CDN) count 
is corrupted for an application link.

B De-acquire manually resources from the switch 
using the following commands from 
overlay 48 (LD 48):

� De-acquire an acquired AGENT: 
DACR AGT <loop> <shelf> <card> <unit> 
<CR>

� De-acquire an acquired ROUTE: 
DACR RTE <route #> <customer #> <CR>

� De-acquire ALL acquired devices on a 
specified link: DACR ALL <link #> <CR>

C De-acquire manually resources from the switch 
using the following commands from 
overlay 23 (LD 23):

� De-acquire an acquired CDN:
REQ <DACR>
TYPE <CDN>
CUST <customer #>
CDN <XXXX>

� De-acquire an acquired ACD-DN:
REQ <DACR>
TYPE <ACD>
CUST <customer #>
ACDN <XXXX>

Note: You can use overlays 10, 11, 20, 21, or 23 to confirm 
that the action is carried out successfully on your device.
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Network troubleshooting

In this chapter
Symptom 1: Server fails to connect to any network 54

Symptom 2: Server fails to connect to the embedded LAN (ELAN) 55

Symptom 3: Server fails to connect to the CLAN (Customer LAN) 58

Symptom 4: The CallPilot server is unable to communicate over the 
network (the ELAN, CLAN, or both) 60

Symptom 5: 201i server is unable to communicate over the network with 3COM 
Megahertz CLAN 64
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Symptom 1: Server fails to connect to any network

Diagnostic steps Resolution

Check Windows NT networking.

1 Verify that the network icon appears on the 
Windows NT desktop.

2 702t, 1001rp, or 1002rp server: If the 
connection cards do not come up, there may 
be I/O conflicts. Check your system 
resources in Windows NT by selecting Start 
> Programs > Administrative Tools 
(Common) > Windows NT Diagnostics and 
click on the Resources tab.

3 Ensure that you have the correct IRQ 
settings. Refer to the documentation for 
your server:

� CallPilot Installation and 
Configuration, Part 5: 702t Server 
Maintenance and Diagnostics, “IRQ 
mapping table” in “702t reference 
material”

� CallPilot Installation and 
Configuration, Part 5: 1001rp Server 
Maintenance and Diagnostics, “IRQ 
mapping table” in “1001rp reference 
material” 

� CallPilot Installation and 
Configuration, Part 5: 1002rp Server 
Maintenance and Diagnostics, “IRQ 
mapping table” in “1002rp reference 
material”

A Remove and reinstall Network cards. 
Refer to the documentation for your 
server: 

� CallPilot Installation and 
Configuration, Part 5: 702t 
Server Maintenance and 
Diagnostics, “Replacing network 
cards”

� CallPilot Installation and 
Configuration, Part 5: 1001rp 
Server Maintenance and 
Diagnostics, “Replacing network 
cards”

B Contact your Nortel Networks 
technical support representative for 
assistance.
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Symptom 2: Server fails to connect to the embedded LAN (ELAN)

Diagnostic steps Resolution

Ping the ELAN Ethernet controller.

1 Obtain the Network Controller’s IP address 
and open a DOS session from within 
Windows NT.

2 At the command line, type ping <ELAN IP 
address> (for example, ping 45.235.0.1).

3 Windows NT should display a summary 
(based on four attempts) indicating whether 
or not there was packet loss. A properly 
configured system will display “Packets: 
Sent=4, Received=4, Lost=0”.

4 If the test fails then there is a problem with 
the software configuration of the network 
adapter card.

A Check the configuration of the 
network adapter card using Control 
Panel > Network. Refer to CallPilot 
Installation and Configuration, Part 
4: Software Installation and 
Maintenance, “Installing network 
adapters” in “Operating system 
reference information.”

Check the switch IP address.

5 If network changes have been made, restart 
the server.

6 Restart the switch to verify its IP 
assignment on the server.

7 Open a DOS session and ping the switch IP 
address. (for example, ping 45.235.1.125).

8 If you cannot ping the switch, the physical 
connection between the CallPilot server 
and the switch may be defective.

B Replace the network cable between 
CallPilot and the switch.

1001rp or 1002rp server: Check the network card.

9 Check the network card settings in Control 
Panel > Network.

10 If network changes have been made, restart 
the server.

11 Ping the switch.

12 If the problem still exists, then the network 
cables or the MAU (multi auxiliary unit) 
may be defective.

13 Restart the switch to verify that the switch 
IP address is correctly assigned.

C Replace the network cable between 
CallPilot and the switch.
Troubleshooting Reference 55



Network troubleshooting Standard 1.0
1001rp or 1002rp server: Ping the switch.

14 Ping the switch again.

15 If this fails then the ELAN card may be 
defective.

D Replace the ELAN card.

1001rp server: Potential network problem.

16 If the ELAN still doesn’t work, there may 
be a problem elsewhere in the network 
infrastructure.

E Contact your Nortel Networks 
technical support representative for 
assistance.

702t server: Check the network card.

Note: The 702t ELAN network interface is embedded 
on the main board.

17 Check the on-board ELAN network 
interface settings.

18 If network changes have been made, restart 
the server.

19 Ping the switch.

20 If the problem still exists, then the network 
cables may be faulty or the MAU (multi 
auxiliary unit) may be faulty.

21 Restart the switch to verify its IP 
assignment on the server.

F Replace the network cable between 
the server and the switch.

702t server: Ping the switch.

22 After the network cable is replaced. Ping 
the switch again.

23 If this fails than the problem may be with 
the on-board ELAN network interface 
settings.

G Contact your Nortel Networks 
technical support representative for 
assistance.

201i server: Check the network card driver.

24 Verify that the driver is listed in the Control 
Panel Network settings.

25 Under the Adapters tab, verify that the 
AMD PCNet driver is present. (AMD and 
3COM drivers should be present).

26 The ELAN cannot function if the drivers 
are not present.

H Load the network adapter driver. 
Refer to CallPilot Installation and 
Configuration, Part 4: Software 
Installation and Maintenance, 
“Installing network adapters” in 
“Operating system reference 
information.”

Symptom 2: Server fails to connect to the embedded LAN (ELAN)

Diagnostic steps Resolution
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201i server: Check the network cable.

27 Check the network cable.

28 Network crossover cables are not 
supported.

29 Visually inspect both ends of the cable. 
Ensure the cable is wired straight through 
(pin1->pin1, pin2->pin2, and so forth).

30 Perform a continuity check using a simple 
ohmmeter (if available). (For example, 
pin1->pin1, pin2->pin2, and so on.)

31 If this test fails then the Ethernet cable may 
be defective.

I Replace the network cable. 

201i server: Check the network cable connections.

32 Verify that the ELAN cable is properly 
connected to the first RJ45 connector of the 
NTRH09AA breakout box. The ELAN will 
not function if it’s plugged into the second 
jack.

J Unplug the Ethernet connection on 
the right and plug it into the left (or 
first) RJ45 connector on the 
NTRH09AA breakout box.

201i server: Check the Ethernet MAC address.

33 Each Ethernet controller has its own MAC 
or Physical address.

34 Open a DOS session window from within 
Windows NT and, from the command line, 
type ipconfig/all. Each adapter will display 
its Mac (physical) address.

35 Verify that each address is valid. A MAC 
address consists of a similar of numbers 
and letters of xx-xx-xx-xx-xx-xx. (For 
example, 00-C0-4F-04-88-85).

36 If the sequence contains all FFs then the 
201i server is defective.

K Replace the 201i server. Contact your 
Nortel Networks technical support 
representative for assistance.

Symptom 2: Server fails to connect to the embedded LAN (ELAN)

Diagnostic steps Resolution
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Symptom 3: Server fails to connect to the CLAN (Customer LAN)

Diagnostic steps Resolution

Ping the CLAN Ethernet controller.

1 Obtain the Network Controller’s IP address 
and open a DOS session from within 
Windows NT.

2 At the command line, type ping <CLAN 
IP> (for example, ping 45.235.0.1).

3 Windows NT should display a summary 
(based on four attempts) indicating whether 
or not there was packet loss. A properly 
configured system will display “Packets: 
Sent=4, Received=4, Lost=0”.

4 If the test fails then there is a problem with 
the software configuration of the network 
adapter card.

A Check the configuration of the 
network adapter card using Control 
Panel > Network. Refer to CallPilot 
Installation and Configuration, Part 
4: Software Installation and 
Maintenance, “Installing network 
adapters” in “Operating system 
reference information.”

Ping the customer network.

5 If network changes have been made, restart 
the server.

6 Check the IP setting of the customer's 
network adapter to ensure you have the 
correct IP address.

7 Open a DOS session and ping the 
customer's PC. (For example, ping 
45.235.1.125).

8 If the problem still exists, then the network 
cables or Token Ring MAU (multi auxiliary 
unit) may be faulty.

B Replace the network cable between 
CallPilot and hub.

702t, 1001rp or 1002rp server: Check the network 
card settings.

9 Check the network card settings in Control 
Panel > Network.

10 If network changes have been made, restart 
the server.

11 Ping another server.

12 If the problem still exists, then the network 
cables or the MAU (multi auxiliary unit) 
may be faulty.

C Replace the network cable between 
CallPilot and the local network hub.
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201i server: Check 201i seating.

13 The 201i server may not be firmly seated.

D Power down the 201i server and 
remove it from the switch for about 
one minute.

E Reinsert the 201i server.

201i server: Check network drivers.

14 Verify that the driver is present within the 
Network settings in the Control Panel.

15 Under the Adapters tab verify that the 
3COM driver is present. (AMD and 3COM 
drivers should be present).

16 The CLAN cannot function if the drivers 
are not present.

F Load the correct network adapter 
driver. Refer to CallPilot Installation 
and Configuration, Part 4: Software 
Installation and Maintenance, 
“Installing network adapters” in 
“Operating system reference 
information.”

201i server: Check the network cable.

Note: Network crossover cables are not supported.

17 Visually inspect both ends of the cable. 
Ensure the cable is wired straight through 
(pin1->pin1, pin2->pin2, and so on).

18 Perform a continuity check by using a 
simple ohmmeter (if available) (pin1-
>pin1, pin2->pin2, and so on). If this test 
fails, the Ethernet cable may be defective.

G Replace the defective network cable. 

201i server: Check the physical connection.

19 Verify that the CLAN cable is properly 
connected to the first RJ45 connector of the 
NTRH09AA breakout box.
Note: The CLAN cannot function if it is 
connected to the first RJ45 connector.

H On the NTRH09AA breakout box, 
unplug the Ethernet connection on 
the left (first) RJ45 connector and 
plug it into the right (second) RJ45 
connector.

Symptom 3: Server fails to connect to the CLAN (Customer LAN)

Diagnostic steps Resolution
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Symptom 4: The CallPilot server is unable to communicate over the 
network (the ELAN, CLAN, or both)

Diagnostic steps Resolution

Physical Layer-1

1 Verify the integrity of the server’s ELAN 
network interface card. Refer to the 
documentation for the card and use the 
diagnostic utilities supplied by the card 
manufacturer.

2 Verify the integrity of the server’s CLAN 
network interface card. Refer to the 
documentation for the card and use the 
diagnostic utilities supplied by the card 
manufacturer.

3 Verify the integrity of the transceivers (if 
used). Refer to the transceiver 
documentation for diagnostic steps.

4 Verify the integrity of the cables from the 
server to the hubs·

� Use cable testers and/or an ohmmeter.

� Ensure the physical characteristics are 
within technical specifications (for 
example, cable grade, length, shielding, 
and so on.)

5 Verify the integrity of the terminators (if 
10Base2 or 10Base5 cables are used).
Note: The two terminators should measure 
50 ohms each.

6 Verify the integrity of the network devices 
such as hubs, bridges, routers, and Ethernet 
switches.

� Refer to the device documentation for 
diagnostic steps.

� Consult the end-customer's Network 
Operations department.

A Replace the defective hardware 
component.

B If the defective part is a Nortel-
supplied component, contact your 
Nortel Networks technical support 
representative to report the diagnostic 
results.

C If all diagnostics passed, proceed to 
test the Data Link Layer.
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Data Link Layer-2

7 Verify the ELAN network driver and its 
version. (Refer to the ELAN card 
documentation for the driver name and 
installation procedures.)

8 Verify the network driver and its version for 
the CLAN card. (Refer to the CLAN card 
documentation for the driver name and 
installation procedures.)

9 Verify the ELAN and CLAN driver 
configurations. Refer to CallPilot 
Installation and Configuration, Part 4: 
Software Installation and Maintenance, 
“Installing network adapters” in “Operating 
system reference information.”

D Install the appropriate driver for the 
associated network interface card 
(the make and model of the driver 
need to match those of the card).

E Make the applicable configuration 
changes within the driver 
configuration utility (for example, 
IRQ settings, 10 MBPS versus 100 
MBPS mode, and so on).

F If all diagnostics all passed, proceed 
to test the Network and Transport 
layers.

Network Layer-3 and Transport Layer-4

10 Verify that TCP/IP is installed. Check the 
Network settings in the Control Panel.

11 Verify the ELAN and CLAN IP 
configurations (for example, address, 
subnet mask, gateway, bindings, and so on).

� At the server, open a DOS command 
window and type: ipconfig/all.

� Verify that the ELAN and CLAN 
network interface cards are recognized.

� Verify that the ELAN card physical 
address is associated with the ELAN IP 
address.

� Verify that the ELAN subnet mask is 
correct and the default gateway address 
is on the same ELAN subnet.

� Verify the CLAN card physical address 
is associated with the CLAN IP 
address.

� Verify the CLAN subnet mask is correct 
and the default gateway address is on 
the same CLAN subnet.

G Add missing TCP/IP components.

H Correct configuration settings if 
necessary.

I Consult the end-customer's network 
operations department.

J If all diagnostics passed, proceed to 
test the Session and Presentation 
layers.

Symptom 4: The CallPilot server is unable to communicate over the 
network (the ELAN, CLAN, or both)

Diagnostic steps Resolution
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Session Layer-5 and Presentation Layer-6

12 Verify the location and version of 
Winsock.dll:

� Use Find Files or Folders from the Start 
menu to locate the winsock.dll file.

� Check the version and date of the 
winsock.dll file.

K If winsock.dll is missing, install it 
according to the Windows NT 
documentation.

L Verify that the location and version of 
winsock.dll correspond to those used 
by Windows NT.

M If all diagnostics all passed, proceed 
to test the Application layer.

Application Layer-7

13 Verify that the server can communicate 
over the ELAN. From the server’s 
command prompt, ping the following (in 
sequence):

� Ping 127.0.0.1 to verify the integrity of 
server’s TCP/IP stack.

� Ping the server’s ELAN IP address to 
verify the server’s ELAN IP 
configuration.

� Ping the switch’s ELAN IP address to 
verify the integrity of hardware and the 
network O/S on both the server and the 
switch.

� Ping an operational PC's IP address on 
the ELAN to verify the integrity of 
cables and hub.

14 Verify that the server can communicate 
over the CLAN. From the server's 
command prompt, ping the following (in 
sequence):

� Ping 127.0.0.1(To verify the integrity of 
server's TCP/IP stack.)

� Ping the server's CLAN IP address to 
verify the server's CLAN IP 
configuration.

� Ping an operational PC's IP address on 
the same subnet to verify the integrity 
of hardware and the network O/S.

Continued on the next page.

N Verify and correct the TCP/IP 
settings and other networking 
settings on the server. Refer to 
CallPilot Installation and 
Configuration, Part 4: Software 
Installation and Maintenance, 
“Installing network adapters” in 
“Operating system reference 
information.”

Symptom 4: The CallPilot server is unable to communicate over the 
network (the ELAN, CLAN, or both)

Diagnostic steps Resolution
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Application Layer-7 (continued)

� Ping the default gateway address on the 
same CLAN subnet to verify the 
integrity of the routers.

� Ping an operational PC’s IP address on 
a different subnet to verify the integrity 
of the router configuration.

See the previous page.

15 Does the problem still exist? O Contact your Nortel Networks 
technical support representative for 
assistance.

Symptom 4: The CallPilot server is unable to communicate over the 
network (the ELAN, CLAN, or both)

Diagnostic steps Resolution
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Symptom 5: 201i server is unable to communicate over the network with 
3COM Megahertz CLAN

Diagnostic steps Resolution

Check if 3Com Megahertz Driver is loaded

1 Ping 127.0.0.1 (to test TCP/IP installation).

2 Ping your IP address (to test proper driver 
for the card) 

3 If both tests pass, go to setup 2

4 If both tests fail, reload the TCP/IP drivers.

A If the first test passed but the second 
one did not and you are sure the TCP/
IP configuration was correct then 
proceed as follows:

� Remove the 3Com Megahertz 
LAN PC Card from the list of the 
adapters

� Shut down the system and 
remove the network card

� Start the system and then shut it 
down again.

� Put back the network card and 
start the system.

� Add the 3Com Megahertz LAN 
PC Card: Right click on the 
Network Neighborhood > 
Properties >Adapters tab and 
then click Add > Have Disk. 
Type C:\ El3c589\disk1 and 
select 3Com Megahertz LAN PC 
adapter.

TCP/IP is correctly configured but you cannot 
access the network

5 Check as follows 

� Ping 127.0.0.1 (to test TCP/IP 
installation).

� Ping your IP address (to test proper 
driver for the card).

� Ping other IP addresses on your subnet 
(to test subnet mask, gateway, and a 
faulty network card or cables).

B If the first two tests passed but the 
third one did not and you are sure the 
TCP/IP configuration was correct 
then proceed as follows:

� Remove the 3Com Megahertz 
LAN PC Card from the list of the 
adapters.

� Shut down the system and 
remove the network card.

� Start the system and then shut it 
down again.

� Install a new network card and a 
new cable, and then start the 
system.
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TCP/IP is correctly configured but you can not 
access the network (continued)

� Add the 3Com Megahertz LAN 
PC Card: Right click on the 
Network Neighborhood > 
Properties > Adapters tab and 
click Add > Have Disk. Type C:\ 
El3c589\disk1 and then select 
3Com Megahertz LAN PC 
adapter.

6 Does the problem still exist? C Contact your Nortel Networks 
technical support representative for 
assistance.

Symptom 5: 201i server is unable to communicate over the network with 
3COM Megahertz CLAN

Diagnostic steps Resolution
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C h a p t e r  4

Remote access troubleshooting

In this chapter
Symptom 1: Unable to connect to CallPilot server using pcAnywhere 68

Symptom 2: Dial-Up Networking connects, but the pcAnywhere connection on the administrative 
PC fails 69

Symptom 3: The administrative PC cannot access shared network resources when a dialup 
connection is established 70

Symptom 4: Remote modem answers, Dialup Networking displays ’Verifying User’ message, and 
logon process fails. 71

Symptom 5: pcAnywhere connects, but the file transfer program is not launched and Ctrl-Alt-Del 
does not work 72

Symptom 6: pcAnywhere connects, but updates are extremely slow, or only a small portion of the 
screen is refreshed 73

Symptom 7: Remote Access Service (RAS) is not running 74
Troubleshooting Reference 67



Remote access troubleshooting Standard 1.0
Symptom 1: Unable to connect to CallPilot server using pcAnywhere

Diagnostic steps Resolution

Check modem and RAS.

1 Verify that the modem is on and physically 
connected to the CallPilot server.

2 Place a call to the modem and verify that it 
is answered.

3 Verify that RAS is running on the server. 
ATTENTION You cannot establish a 
pcAnywhere modem to modem connection 
while Remote Access Service (RAS) is 
running. 

A Stop RAS from Control Panel > 
Network > Services.

B Establish a pcAnywhere modem to 
modem connection. Refer to the 
CallPilot 2.0 Administrator’s Guide, 
“Establishing a connection using 
Dial-Up Networking” in 
“Configuring remote administration 
of the CallPilot server.” 

C Terminate the pcAnywhere modem 
to modem connection before 
restarting RAS.

4 Does the problem still exist? D Call Your Nortel Networks technical 
support representative for assistance.
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Symptom 2: Dial-Up Networking connects, but the pcAnywhere 
connection on the administrative PC fails

Diagnostic steps Resolution

Verify the server configuration.

1 Verify that pcAnywhere is installed on the 
server by checking the Windows NT Start 
menu.

2 Run ipconfig from the DOS prompt on the 
server to verify that the Nortel Support 
entry appears in its pcAnywhere 
configuration.

A Install pcAnywhere if not already 
installed. Refer to CallPilot 
Installation and Configuration, Part 
4: Software Installation and 
Maintenance, “Updating the 
Windows NT operating system for 
CallPilot 2.0” in “Installing and 
configuring Windows NT.”

Ping the server. 

3 Restart pcAnywhere on the administrative 
PC.

4 Run ipconfig from the DOS prompt on the 
administrative PC to verify the 
pcAnywhere client configuration.

5 If the ELAN adapter is not the first adapter 
listed, pcAnywhere will not work.

B Restore the adapter, using an ELAN 
subnet address space for the RAS:

� In Control Panel > Network > 
Adapters, locate the adapter that 
must be first on the ipconfig list.

� Remove the adapter and restart 
the server.

� In Control Panel > Network > 
Adapters, add the adapter back 
and reconfigure the TCP/IP 
settings.

C Reinstall the service pack from the 
server installation CD and restart the 
server again. Refer to CallPilot 
Installation and Configuration, Part 
4: Software Installation and 
Maintenance, “Installing Windows 
NT Service Pack 6a” in “Installing 
and configuring Windows NT.”

Verify adapter settings. 

6 Run ipconfig to verify that the restored 
adapter is first on the list.

7 Check the address space allocated to the 
RAS (Control Panel > Network > Services 
> RAS).

8 Ping the server.

D If these steps fail, contact your Nortel 
Networks technical support 
representative for assistance.
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Symptom 3: The administrative PC cannot access shared network 
resources when a dialup connection is established 

Diagnostic steps Resolution

Check the dialup connection configuration.

1 Verify that the Dial-Up Networking 
connection is active.

2 Open Dial-Up Networking from Start > 
Programs > Accessories.

3 Click the Server tab for the phone book 
entry.

4 Verify the RAS settings. 

A Uncheck TCP/IP settings and use 
default gateway on remote network.

Verify network settings.

5 The network settings may be incorrect. 

B Contact the network administrator for 
the correct network settings.

6 Does the problem still exist? C Contact your Nortel Networks 
technical support representative for 
assistance.
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Symptom 4: Remote modem answers, Dialup Networking displays ’Verifying User’ 
message, and logon process fails.

Diagnostic steps Resolution

Check RAS. 

1 Verify that RAS is running. 

2 Verify that the RAS static address pool is 
configured for the valid IP address pool on 
the first installed LAN adapter (ELAN 
usually).

A Correct the static IP address. Check 
the IP address in the Network 
Properties under Protocols > TCP/IP 
Protocol > Properties > IP Address.

3 Does the problem still exist? B Contact your Nortel Networks 
technical support representative for 
assistance.
Troubleshooting Reference 71



Remote access troubleshooting Standard 1.0
Symptom 5: pcAnywhere connects, but the file transfer program is not 
launched and Ctrl-Alt-Del does not work

Diagnostic steps Resolution

Check video driver. 

1 Verify that pcAnywhere supports the 
server’s video driver. For the list of video 
adapters supported by pcAnywhere, refer to 
the support section of the Symantec web 
site.

A If necessary, replace the server’s 
video driver. Refer to the 
documentation for the video card.

2 Does the problem still exist? B Contact your Nortel Networks 
technical support representative for 
assistance.
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Symptom 6: pcAnywhere connects, but updates are extremely slow, or only 
a small portion of the screen is refreshed

Diagnostic steps Resolution

Verify that pcAnywhere is running in Video 
Compatibility mode.

1 On the CallPilot server, start pcAnywhere.

2 Open File > Application Options, and then 
click the Host Operation.

A If necessary, set the Video mode 
selection item to Compatibility.

3 Does the problem still exist? B Contact your Nortel Networks 
technical support representative for 
assistance.
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Symptom 7: Remote Access Service (RAS) is not running

Diagnostic steps Resolution

Verify the RAS startup settings.

1 Check the RAS service startup settings. 
Select Control Panel > Network > Services 
> Remote Access Service > Properties and 
click on the Network button. Ensure that 
NetBEUI is unchecked.

2 Check the event log for possible RAS 
errors.

A If necessary, uncheck NetBEUI.

3 Does the problem still exist? B Reinstall the service pack and restart 
the server.

4 Does the problem still exist? C Contact your Nortel Networks 
technical support representative for 
assistance.
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Application troubleshooting

In this chapter
Symptom 1: Call answered, no voice 76

Symptom 2: A user cannot log on to the mailbox from an external phone 79

Symptom 3: Speech recognition does not work 80

Symptom 4: Users cannot print or receive faxes 81
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Symptom 1: Call answered, no voice

Diagnostic steps Resolution

Check the DS0s and DSPs.

1 Verify that the DS0s and DSPs are in 
service and accepting calls. Refer to the 
documentation for your server:

� CallPilot Installation and 
Configuration, Part 5: 201i Server 
Maintenance and Diagnostics, “System 
Monitor” in “Using CallPilot system 
utilities”

� CallPilot Installation and 
Configuration, Part 5: 702t Server 
Maintenance and Diagnostics, “System 
Monitor” in “Using CallPilot system 
utilities”

� CallPilot Installation and 
Configuration, Part 5: 1001rp Server 
Maintenance and Diagnostics, “System 
Monitor” in “Using CallPilot system 
utilities”

� CallPilot Installation and 
Configuration, Part 5: 1002rp Server 
Maintenance and Diagnostics, “System 
Monitor” in “Using CallPilot system 
utilities”

A If the DS0s and DSPs do not become 
active, verify the switch 
configuration.

B If the DS0s and DSPs are active but 
there is still no voice, verify the 
prompt installation. Refer to 

� CallPilot Installation and 
Configuration, Part 3: Meridian 
1 and CallPilot Server 
Configuration, “Configuring the 
Meridian 1 switch”

� CallPilot Installation and 
Configuration, Part 3: 
Succession CSE 1000 and 
CallPilot Server Configuration, 
“Configuring the Succession 
CSE 1000 system”

Verify the switch configuration.

2 From the switch administration console, 
load overlay 32 (LD 32) and verify that the 
status of the defined DS0 channels are 
either Idle or Login.

C If the channels were disabled (but not 
because of a prior maintenance 
action), use overlay 32 (LD 32) to 
enable them. 

Check the server’s IP address.

3 Determine whether the IP address of the 
CallPilot server has been changed since the 
last restart. 

D If the IP address was changed, shut 
down and restart the CallPilot server. 

Check Windows NT Service Pack.

4 Determine if Windows NT Service Pack 6a 
has been reapplied to the CallPilot server.

E Update the Service Pack if it is not 
already at 6a.
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Verify MGate version and placement.

5 If the system uses an MGate card on an 
Option 11 switch, verify that 

� The MGate card is Revision 4 or later.

� The card slot it is not installed in slot 
10.

F If the MGate card is Revision 3 or 
earlier, replace it with Revision 4 or 
later. 

G If the MGate card is installed in slot 
10, move the card to a different slot.

Verify the prompt installation.

6 Open the installation log file 
(d:\nortel\sysops\mpcx\langprompts.
<xxxx>.log).

7 Check the last line of the log file. It should 
read “Prompt Installation completed 
successfully.”

8 If you cannot verify that the prompts were 
installed successfully, they may not have 
been.
Note: xxxx is the Nortel Language ID (for 
example, 1033 is for US English, 17 is for 
Japanese). The Nortel Language ID is 
specified in the cdstruct.lng file, which is 
located in the root directory of the language 
CD.

H Reinstall the prompts. Refer to 
CallPilot Installation and 
Configuration, Part 4: Software 
Installation and Maintenance, 
“Reinstalling languages” in 
“Reinstalling CallPilot server 
software.”

Verify the new configuration.

9 In the d:\nortel\langXXXX\voice\map 
directory, verify that the file sysmap.mxxxx 
exists, has the date and time of the prompt 
installation, and has a reasonable size 
(5K+).

10 Verify that all of the .l files in the 
d:\nortel\langxxxx\voice\template directory 
have the date/time of prompt installation.

11 Verify that the file imap_lng.txt exists in the 
d:\nortel\langXXXX\desktop directory.

12 If the fax feature is installed, verify that the 
six .cptemp and .bmp files exist in the 
d:\nortel\langXXXX\fax directory.

I If any of the verification steps fail, 
the language must be reinstalled.
Note: Even if all the above checks 
are valid, the language still may not 
have installed correctly.

Symptom 1: Call answered, no voice

Diagnostic steps Resolution
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Verify the new configuration (continued).

13 If the ASR (automatic speech recognition) 
language component was installed (or was 
supposed to be installed), verify that the 
d:\nortel\langxxxx\asr directory exists and 
contains three .ctx files, three .cfg files, and 
one .asr file.

14 If ASR language component was installed, 
verify that the ASR load was flashed in the 
DSP. 

15 From an MS-DOS Prompt window:

� Change to the dsp directory on the D 
drive.

� For each DSP installed, enter the 
command: coffup <dsp#>.
Example: coffup 1

� Verify that the names of the ASR load 
for a specific language are in the 
flashnames.dat file in the root directory 
of the language CD.

See the previous page.

16 MPB cables may be installed backwards 
(TRP) systems.

J Try rolling the cables then retest.

17 Does the problem still exist? K Contact your Nortel Networks 
technical support representative for 
assistance.

Symptom 1: Call answered, no voice

Diagnostic steps Resolution
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Symptom 2: A user cannot log on to the mailbox from an external phone

Diagnostic steps Resolution

Verify internal access.

1 Verify that the user can log on from an 
internal phone. 

A At the CallPilot Manager interface:

� Connect to the server.

� Click User.

� Click User search.

� Enter the search criteria for the 
user.

� Ensure that the logon status is 
enabled.

Verify user rights.

2 Verify that the user has external logon 
rights.

B Ensure that external logon is enabled. 
Refer to the CallPilot 2.0 
Administrator’s Guide, “Controlling 
access to mailboxes” under 
“Configuring mailbox security” in 
“Securing the CallPilot system.”

3 Does the problem still exist? C Contact your Nortel Networks 
technical support representative for 
assistance.
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Symptom 3: Speech recognition does not work

Diagnostic steps Resolution

Verify that speech recognition resources are 
assigned to the DN.

1 At the CallPilot Manager interface: 
Connect to the server, click System, click 
Service Directory number.

2 View the Speech Recognition Service 
Directory Number.

3 Verify that the Media type is “Speech Rec.”

A Change the DN media type to 
“Speech Rec.”

Verify speech recognition on keycode.

4 If “Speech Rec” is not on the Media type 
list, the server’s keycode does not enable 
the speech recognition feature. 
Note: The keycode must enable Speech 
Recognition (SR) languages and seats for 
the Speech Rec. channels to answer 
correctly.

B Perform a keycode expansion. 
Contact your Nortel Networks 
technical support representative for 
assistance.

Verify the prompt installation.

5 Check the language installation log file: 
d:\nortel\sysops\mpcx\
langprompts.<xxxx>.log. 

6 Verify that the last line of the log file reads 
“Prompt Installation completed 
successfully.”

C Reinstall the language. Refer to 
CallPilot Installation and 
Configuration, Part 4: Software 
Installation and Maintenance, 
“Reinstalling languages” in 
“Reinstalling CallPilot server 
software.”

7 Does the problem still exist? D Contact your Nortel Networks 
technical support representative for 
assistance.
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Symptom 4: Users cannot print or receive faxes

Diagnostic steps Resolution

Verify that fax resources are assigned to the fax 
messaging DN.

1 At the CallPilot Manager interface: 
Connect to the server, click System, click 
Service Directory number.

2 View the Service Directory Number.

3 Verify that the Media type is “Fax.”

A Change the DN media type to “Fax.”

Verify that Fax feature is on keycode.

4 If “Fax” is not on the Media type list, the 
server’s keycode does not enable fax 
features.

B Perform a keycode expansion. 
Contact your Nortel Networks 
technical support representative for 
assistance.

5 Does the problem still exist? C Contact your Nortel Networks 
technical support representative for 
assistance.
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Meridian Mail migration troubleshooting

In this chapter
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not recognize a user receiving an incoming call 89
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Symptom 1: Error reading tape during data transfer or message migration

Diagnostic steps Resolution

Verify the log file

1 Open the migration transaction log file on 
CallPilot server. The transaction log is 
located in the \nortel\MPCX\Migration 
folder on CallPilot.

2 Check the error description in the log file 
for more information. 

A Correct the error according to the log 
information. If you could not find 
any solution, go to the next step.

Verify the type of the tape.

3 Check if the tape type is correct according 
the CallPilot product specification.

B Use the correct tape to collect data 
again.

Verify the tape drive.

4 Check if the tape drive should support the 
migration tape.

5 Check if the internal or external tape drive 
that you are using is installed or connected 
well.

C Install or connect the tape drive 
properly.

Verify the tape driver.

6 Open the Tape Devices applet on the 
Control Panel, and determine if the required 
devices and drivers are installed and loaded 
or started.

D If the device driver is missing or not 
started, try restarting it. If you still 
could not start it, reinstall the tape 
device driver and then restart the 
CallPilot server.

Try rerunning the tape on the same CallPilot 
server.

7 Type the same command in the command 
line window to start the migration.

E If error still exists, try the next step.

Try running another data or message tape on the 
same CallPilot server.

8 The tape should be proved to be good 
before. Type the correct command in the 
command line window to start the 
migration. If situation does not allow you to 
do this, skip this step.

F If the error disappears for step 8, it is 
tape problem. Try another blank tape 
to perform the data collection and 
then do the migration again.

G If the error still exists for step 8, the 
problem is on CallPilot server. Try 
performing a hardware restart on the 
CallPilot server.
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Try rerunning the tape on a different CallPilot 
server.

9 Type the correct command in the command 
line window to start the migration. If 
situation does not allow you to do this, skip 
this step.

H If the error disappears for step 9, the 
tape is good, the problem is on 
CallPilot server. Try performing a 
hardware restart on the CallPilot 
server.

I If the error still exists for step 9, it is 
a tape problem. Try another blank 
tape to perform the data collection 
and then perform the migration 
again.

10 Does the problem still exist? J Contact your Nortel Networks 
technical support representative for 
assistance.

Symptom 1: Error reading tape during data transfer or message migration

Diagnostic steps Resolution
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Symptom 2: All users could not be migrated due to invalid user preferred language ID

Diagnostic steps Resolution

Verify the CallPilot version and Meridian Mail 
Migration Utility tape version.

1 Open the migration transaction log file 
(\Nortel\MPCX\migration\
MigTransaction.log) on the CallPilot 
server. Check the error description in the 
user migration.

2 Check if the error is like: 
ERROR:(USRAPI):(55122):Invalid 
input USER PREFFERRED LANG ID:

A If the answer is yes for step 2, check 
the current CallPilot server release 
version. If you are using the old 
CallPilot version, or there is a version 
mismatch between the Migration 
utility tape used on Meridian Mail for 
data collection and the CallPilot 
release, the problem may happen. Try 
upgrading the CallPilot server or use 
the old Meridian Mail migration tape 
for data collection according to the 
supported migration specification. 

B If the answer is no for step 2, contact 
your Nortel Networks technical 
support representative for assistance.

3 Does the problem still exist? C Contact your Nortel Networks 
technical support representative for 
assistance.
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Symptom 3: Failed to create map directory

Diagnostic steps Resolution

Verify the map file

1 Open the migration transaction log file 
(\Nortel\MPCX\migration\
MigTransaction.log) on the CallPilot 
server. Check the error description in the 
user migration.

2 Check if the error is like: 
ERROR:(MAPFILE):(100): Map 
directory creation error:

A If the answer is no, contact your 
Nortel Networks technical support 
representative for assistance. 
If the answer is yes, have you 
changed your current directory in 
command line to 
\norte\mpcx\migration? If necessary, 
change your directory and start the 
migrate.exe program again.
Note: You should always start the 
migration program from the directory 
\norte\mpcx\migration.

B If you still have problems when you 
start the program from the correct 
directory, check the same directory to 
find a file named nmmgmap.dat. 
Restore this file back to original if it 
was accidentally renamed or moved 
to other directory. 
Reinstall the CallPilot software if this 
map file is missing.
Note: The nmmgmap.dat file must 
exist under the same directory in 
which migrate.exe is located.

3 Does the problem still exist? C Contact your Nortel Networks 
technical support representative for 
assistance.
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Symptom 4: Automatic log file backup failed

Diagnostic steps Resolution

Verify the disk space.

1 Open the migration transaction log file 
(\Nortel\MPCX\migration\
MigTransaction.log) on the CallPilot 
server. Check the error description in the 
user migration.

2 Check if the error is like: Could not 
backup the. transaction log file

A If the answer is yes, check the disk 
free space of the disk drive in which 
the directory \Nortel\mpcx\migration 
is located on the CallPilot server. You 
may run out of disk space. Clean up 
the Recycle Bin or move some log 
files to another disk drive that has 
enough space. Manually back up the 
log file.
Note: For some older CallPilot 
releases, automatic log file backup is 
not supported. Nortel Networks 
recommends that you back up the log 
file manually each time you finish a 
migration tape.

B If the answer is no for step 2, contact 
your Nortel Networks technical 
support representative for assistance.

3 Does the problem still exist? C Contact your Nortel Networks 
technical support representative for 
assistance.
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Symptom 5: On a recently migrated system, a user cannot log on to the mailbox or
CallPilot does not recognize a user receiving an incoming call

Diagnostic steps Resolution

Check user’s class of service

1 On Meridian Mail, determine if the user 
had a personal COS. You can also verify 
this from the migration transaction log file 
(\Nortel\MPCX\migration\
MigTransaction.log) on the CallPilot 
server. 
Note: Before you migrate Meridian Mail 
users to CallPilot, you must reassign the 
personal COS (perhaps to a dummy COS, 
which can be added to Meridian Mail). 
Refer to the Meridian Mail System 
Administration Guide (NTP 555-7001-301) 
for information on how to add and reassign 
Classes of Service. CallPilot will not 
migrate personal COS and those users with 
personal COS. 

D If the user does not have personal 
COS, go to the next step. Otherwise, 
you may do one of the following:

� Recollect user data from 
Meridian Mail after reassigning 
the user COS. Perform the user 
migration again.

� Use CallPilot Manager to add 
non-migrated users to the 
CallPilot system. Refer to the  
CallPilot 2.0 Administrator’s 
Guide.
Note: Before you recreate a user, 
ensure that the user’s DN has not 
already been assigned to another 
user. CallPilot does not allow 
duplicate DNs.

Check user’s mailbox number.

2 On Meridian Mail, ensure that the user has 
a mailbox number that is less than three 
digits in length. You can also verify this 
from migration transaction log file 
(\Nortel\MPCX\migration\
MigTransaction.log) on the CallPilot 
server.
Note: CallPilot does not support mailbox 
numbers less than three digits in length.

E If no, go to the next step. If yes, you 
may do one of the following:

� Recollect user data from 
Meridian Mail after changing the 
user mailbox number. Perform 
the user migration again.

� Use CallPilot Manager to add 
non-migrated users to the 
CallPilot system. Refer to the 
CallPilot 2.0 Administrator’s 
Guide.
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Check migration transaction log file.

3 Check the migration log file 
(\Nortel\MPCX\migration\
MigTransaction.log) to determine if the 
user was migrated successfully.

F If the user was migrated successfully, 
check the CallPilot system sanity. If 
the user failed to be migrated, you 
may do one of the following:

� Recollect user data from 
Meridian Mail after correcting 
the user property or any other 
errors according to the CallPilot 
migration log information. 
Perform the user migration again.

� Use CallPilot Manager to add 
non-migrated users to the 
CallPilot system. Refer to the 
CallPilot 2.0 Administrator’s 
Guide.

4 Does the problem still exist? G Contact your Nortel Networks 
technical support representative for 
assistance.

Symptom 5: On a recently migrated system, a user cannot log on to the mailbox or
CallPilot does not recognize a user receiving an incoming call

Diagnostic steps Resolution
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Part numbers

This section contains a list of most of the parts referenced in this document. It is not meant as a 
comprehensive list of all replaceable parts.

Part Part number

Common parts

Monitor NTRH9011

Keyboard NTRH9013

Mouse NTRH9014

External modem NTRH9016

Modem cable A0601464

Tandberg tape drive NTRH8024

3 ft shielded Ethernet cable A0769309

14 ft shielded Ethernet cable A0769310

1001rp server, CPU, and memory

1001rp AC base server A0732414

1001rp DC base server A0732415

1001rp 220V-only AC base server A0769042

300MHz Pentium II CPU A0735334

8MB SIMM module A0684494

16MB SIMM module A0684496

32MB SIMM module A0684497

64MB SIMM module A0684962

32MB DIMM EDO A0735352

64MB DIMM EDO A0735351

128MB DIMM EDO A0735349

128MB SDRAM DIMM A0803022
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1001rp server: power supplies and cabling

48V DC 400W load sharing hot swap power supply A0723663

220V-only power supply w/o 3.3V output (3 rail) A0769126

Power supply 500W hot swappable A0805434

Power cable A0645811

DC power cable for PS400-48 power supply A0725949

1001rp server: storage devices and cabling

IDE CD-ROM drive NTRH9035

SCSI CD-ROM drive NTRH9005

9GB SCSI SCA hard drive NTRH9053

Female to female SCSI adapter A0684822

Male to male SCSI adapter A0729069

Wide SCSI active terminator A0766997

Narrow SCSI active terminator A0767002

1001rp server networking devices

PCI 10Mb Ethernet adapter NTRH9009

PCI Token Ring network card NTRH9010

PCI 100Mb Ethernet adapter NTRH9036

ISA Token Ring network card NTRH9026

ISA 10Mbps Ethernet adapter NTRH9047

1001rp server: Miscellaneous items

Integrated mouse NTRH9048

Video card NTRH9041

201i server

Daughterboard NTRH13BA

Tape drive NTRH9038

CD-ROM drive NTRH9037

Hard drive NTRH9049

Part Part number
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External SCSI cable assembly NTAK1305

SCSI paddleboard cable assembly NTRH0710

Option 11 SCSI cable assembly NTRH1407

Meridian 1 faceplate to bulkhead SCSI cable NTRH1408

Meridian 1 bulkhead to faceplate SCSI Cable NTRH1409

Breakout box NTRH09AA

Breakout cable NTRH0910/NTRH0911

702t server, CPU, and memory

Base system A0741582

System motherboard A0741581

350MHz Pentium II CPU A0761147

450MHz Pentium II CPU A0761148

32MB SDRAM DIMM module A0741594

64MB SDRAM DIMM module A0741595

128MB SDRAM DIMM module A0744456

702t server: power supplies and cabling

Power cable A0645811

Power supply A0741561

702t server: storage devices and cabling

IDE CD-ROM drive NTRH9035

SCSI CD-ROM drive NTRH9005

Wide SCSI cable—5 connector A0684753

Wide SCSI cable—9 connector A0772567

SCSI cable kit A0764681

Female to female SCSI adapter A0684822

Male to male SCSI adapter A0729069

Wide SCSI active terminator A0766997

Narrow SCSI active terminator A0767002

Part Part number
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702t server: networking devices

PCI 10Mb Ethernet adapter NTRH9009

PCI Token Ring network card NTRH9010

PCI 100Mb Ethernet adapter NTRH9036

ISA Token Ring network card NTRH9026

ISA 10Mbps Ethernet adapter NTRH9047

Part Part number
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